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Introduction

CATBooks is a quick, efficient, easy-to-use program for organizing your book collection.
With CATBooks you can register and look up information about such things as: 

· author, title, release year, publisher, country of origin
· condition, category, type, location,
· edition, printing, pages, ISBN, 
· condition, purchase price and current value.

You can add personal comments for every item. Thirteen special fields enable you to 
customize your catalog. You can even store a bitmap picture of the book cover.
CATBooks includes a loan module that lets you keep track of books on loan, who has 
borrowed, when they were borrowed, when they are due back and how many times they 
have been borrowed.
CATBooks uses a relational database model. This means that you register most information 
only once. For example, an authors name is included in the catalog the first time you add a
book written by this person. Later, you simply choose this name from a list. This type of 
information is stored in "lookup" tables which ultimately save time and valuable disk space 
on your computer.
CATBooks lets you work with an unlimited number of databases. This means that you can 
split your collection into different catalogs and organize it to meet your needs. You can also
merge existing databases. CATBooks includes routines for taking and restoring backup of 
the databases you have created.
CATBooks has impressive and powerful search capabilities. You can search for any 
information you have entered in a catalog. CATBooks lets you cross reference up to five 
fields. This is an extremely flexible way to search and query data. CATBooks has templates 
for many types of reports which you can generate to examine on the screen or print out.
CATBooks comes with a sample database to get you started and a comprehensive context-
sensitive on-line help system.
Before you start using CATBooks, we recommend that you read the User's Guide. In the 
section Procedures some of the most important procedures (for example, how to create a 
database or how to search) are explained in details. The section Windows contains 
information about all CATBooks' windows and dialog boxes. This is the same information 
that is displayed when you press F1 or press the Help button. In addition to this, the help 
file contains information about Menu Shortcuts, The toolbar, Error Messages and Technical 
Information.

Four different icons are used to indicate important information:

Useful tips.



This is important.

This is very important.

Indicates that you may click the 'other' (usually the right) mouse-button on an object 
(button or list) to activate a popup-menu relevant to this object.



Windows

Main Windows 
Dialog Boxes 



Toolbar

    Add new record

    Add new record that is a copy of the active record

    Update sort order

    Go to record by Author

    Go to record by Catalog Number

    Go to record by Title

    Show references to other records based on the keywords

    Go to previous record on the basis on last search

    Search

    Show result of last search

    Go to next record on the basis on last search

    Mark/unmark active record

    View subset (that is, records that are marked)

    Calculate total value

    Print active record (full report)

    Go to first record

    Go to previous record

    Go to next record

    Go to last record

    Show help contents

Press one of these buttons to locate the first record where the first field used in the sort 
criteria starts with this letter. For example, if the records are sorted on Title and you press 
T, CATBooks finds the first record where the title begins with T.



Click with the 'other' mouse-button on  to activate this popup-menu:
· Sort Automatically

This menu lets you specify (without activating the dialog "Preferences") if you want 
CATBooks to automatically update the sort order each time you add a new record.

Click with the 'other' mouse-button  to activate a popup-menu with these options: 
· Find
· Show Field Values
· Simple Search
· Advanced Search
· X-Ref

This menu lets you specify (without activating the dialog "Preferences") what search 
command to activate when you press this button.



Menu Shortcuts

Press To

F2 Go to previous record on the basis of last search
F3 Go to next record on the basis of last search
F4 Show result of last search (all records found in last search)
F5 Go to first record
F6 Go to previous record
F7 Go to next record
F8 Go to last record
F11 Update sort order
F12 Disable the conversion to upper case (first letter in each word) as long as this 

button is pressed.
Ctrl+F2 Loan out active book
Ctrl+F3 Register active book as returned
Ctrl+F4 Register books as returned (show all on loan)
Ctrl+A Go to record by Author
Ctrl+B Activate window "Browse"
Ctrl+C Copy the selection and put it on the clipboard
Ctrl+D Insert current date
Ctrl+E Activate window "Memo"
Ctrl+H Activate window "Active Record"
Ctrl+I Go to record by Catalog Number
Ctrl+L Go to record by Title
Ctrl+M Mark or unmark activate record
Ctrl+N Add new record
Ctrl+O Add new record that is a copy of the activate record
Ctrl+R Activate window "Cover"
Ctrl+S Save changes
Ctrl+T Insert current time
Ctrl+U Register author(s)
Ctrl+V Insert clipboard contents
Ctrl+W Add new item to lookup table
Ctrl+X Cut the selection and put it on the clipboard'
Ctrl+Y Register keywords



Error Messages

482 Default printer not set. Make sure a default printer is set in the Control Panel!
3041 The file VBDB300.DLL has the wrong version and needs to be 

reinstalled. CATBooks' installation program did copy the correct version to your 
hard drive, but this version is now overwritten by another application. You may 
install this file again by following this procedure:
1) Start a "DOS-window" (click on the MS-DOS icon).
2) Insert diskette no. 2 into your diskette drive and type: 

EXPAND A:\VBDB300.DL_ C:\WINDOWS\SYSTEM\VBDB300.DLL
3049 Cannot open database! If you do not exit the program by choosing Exit from 

the File menu (or Close from the main window's Control-menu), for example if 
a system error occurs or there is a power-failure, you may get this error message 
the next time you try to open the database. If this happens, run a utility called 
FIX that was installed to the same directory as CATBooks.

3050 SHARE is not activated! Add SHARE.EXE /L:500 to autoexec.bat (use Notepad) 
and reboot your computer



Technical Support

Technical support is available at no charge if you are a registered user. However, support is 
available only by E-mail or regular mail. Sorry, but we cannot provide telephone support at 
this time. Contact us at:

FNProgramvare
Storgt. 22
N-1531    Moss
Norway

E-mail: fredrik.nordbakke@ostfoldnett.no
World Wide Web: http://www.prodat.no/fnp/eng/

When reporting problems, the more information you can provide the better our response 
can be. If possible, include the following:

· What version of Microsoft Windows are you running? For example, Windows 3.1, 
Windows for Workgroups, Windows NT or Windows 95.

· What version of CATBooks are you running? You can determine this by choosing About
CATBooks from the CATBooks Help menu. Include the entire "version line" in your 
report; for example 3.10.00.

· Is the problem reproducible? If so, how?
· If you see a dialog box with an error message when the problem occurs,    if possible 

include the full text of the dialog box, the text in the title bar and the error number. 



Technical Information

catbook.ini 
"dbname".ini 
Minimum System Requirements 
Files Needed to Run CATBooks 



catbook.ini

This file is automatically created in the WINDOWS directory (usually C:\WINDOWS) the 
first time you run CATBooks, and contains all user specified preferences, window positions 
and the last database opened.

Do not edit this file manually!



"dbname".ini

Each database you create has a corresponding ini-file with the same name as the database
(for example BOOKLIB.MDB and BOOKLIB.INI). This ini-file contains information about 
the browse layout and sort order.



Minimum System Requirements

To run CATBooks you need:
· 386-based PC or better
· Microsoft Windows 3.1 or Windows 95
· 4 Mbytes memory (6 Mbytes is recommended)
· 4 Mbytes available space on the hard disk



Files Needed to Run CATBooks

CATBooks needs the following files:
In the program directory (the same directory where CATBOOK.EXE is located):

CATBOOK.HLP CATBOOK.MEM FIX.EXE

In the SYSTEM directory (usually C:\WINDOWS\SYSTEM):

LHA.DLL VBRUN300.DLL MHTIP.VBX
MHRUN400.DLL CMDIALOG.VBX MSMASKED.VBX
MSAES110.DLL MHCB200.VBX MUSCLE.VBX
MSAFINX.DLL MHCM200.VBX SSDATA2.VBX
MSAJT112.DLL MHPFST.VBX THREED.VBX
MSAJT200.DLL MHPFST.VBX VSVIEW.VBX
VBDB300.DLL MHTAB.VBX

Several report files were copied to the program directory during installation: MEMO.LIN 
(line report), DEFAULT.LIS (list report), AUTHOR.SUM, CATEGORY.SUM, CONDIT.SUM, 
COUNTRY.SUM, LOCATION.SUM, PRINTING.SUM, PUBLISH.SUM and TYPE.SUM 
(summary reports).
A sample database (SAMPLE.MDB) was also copied to the program directory during 
installation. This database contains information about 20 books. We recommend that you 
open the sample database the first time you run CATBooks. Most examples in the 
documentation are referring to this database.
In addition, CATBooks will automatically create the file catbook.ini in your WINDOWS 
directory (usually C:\WINDOWS).



Dialog boxes

A dialog box is window that is shown temporarily after you have selected a command, for 
example chosen a menu option or pressed a button. Dialogs need to be closed before you 
can select another menu option. Buttons with three dots (for example Transfer...) 
activates another dialog box when it is pressed.

Database 
Lookup Tables 
Edit Records 
Search
Reports 
Miscellaneous



Database

Backup Database 
Browse Layout
Change Sort Order
Convert Database
Create New Database 
Define Browse Layout 
Define Sort Order 
Export 
Import
Merge Databases 
Open Database 
Restore Backup
Restore Backup To 
Save Database As
Split Database 
Transfer Field Names 
User-defined Fields 



Lookup Tables

Edit Author 
Edit Borrower
Edit Category 
Edit Condition 
Edit Country 
Edit Edition 
Edit Keyword 
Edit Location
Edit Personal Rating
Edit Printing 
Edit Publisher 
Edit Purchased Where
Edit Type 
Edit User-defined 
Lookup Table Author 
Lookup Table Borrower
Lookup Table Category 
Lookup Table Condition 
Lookup Table Country 
Lookup Table Edition 
Lookup Table Keyword 
Lookup Table Location
Lookup Table Personal Rating
Lookup Table Printing 
Lookup Table Publisher 
Lookup Table Puchased Where
Lookup Table Type 
Lookup Table User-defined 
Transfer Lookup Tables 
Transfer Lookup Tables From 



Edit Records

Author 
Adjust Value 
Keywords
Load Cover 
Loan Out
References 
Returned To Library
Total Value 



Search

Advanced Search 
Advanced Search - Sub-criterion 
Cross References 
Find 
Search Result 
Show Field Values 
Show Field Values - Select Value 
Simple Search 



Reports

Advanced Filter 
Advanced Filter - Sub-criterion 
Choose Field 
Cover Report 
Full Report
Heading 
Insurance Report 
Line Report
List Report
Loan Report - By Borrower
Loan Report - By Title
Loan Report - On Loan
Loan Report - Statistics
Page Setup 
Print Preview 
Properties 
Report - Cross References 
Report - Show Field Values 
Report Lookup Table 
Simple Filter    
Summary Report
View file 



Miscellaneous

About CATBooks 
Preferences 
System Information 



Dialog Backup Database

In this dialog you specify where you want to backup the open database to. Please note that
if a database is too large to fit onto one diskette, it is automatically split in two or more 
parts. The file on diskette no. 1 is named "dbname".001, the file on diskette no. 2 is 
named "dbname".002 and so on.
Please note that you cannot simply copy the necessary file(s) from the diskette(s) to your 
hard disk. You must use CATBooks' internal routines to do this.

Dialog options

Directories
Select the directory where you want to backup the database to.

Drives
Select the drive where you want to backup the database to.

OK
Press this button to accept the selected drive/directory and start the backup process.

Cancel
Press this button to cancel.



Dialog Browse Layout

Use this dialog to select the browse layout you want to activate. Default browse layout is 
Title, Author and Catalog Number. You may define up to 5 browse layouts yourself.

See also: Change Browse Layout 

Dialog options

Active layout
Select the layout to activate.

OK
Press this button to activate the selected layout.

Cancel
Press this button to cancel and close the dialog.

Edit
Press this button to edit the selected layout.



Dialog Change Sort Order

Use this dialog to select the sort order you want to activate. Default sort order is based on 
Title.

See also: Change Sort Order 

Dialog options

Active sort order
Select the sort order to activate.

OK
Press this button to activate the selected sort order.

Cancel
Press this button to cancel and close the dialog.

Edit
Press this button to edit the selected sort order



Dialog Convert Database

This dialog is shown when you try to open a database created with CATBooks v3.10. 
The database must be converted before you can use it in version 3.20. This is done 
automatically. Please note the following:
· The field Memo is split in three.

Dialog options

Transfer Memo to
Choose whether you want to transfer the contents of the Memo field to Comments, 
Synopsis or Reviews.

OK
Press this button to convert the database.

Cancel
Press this button if you do not want to convert the database.



Dialog Create New Database

In this dialog you specify the name of the new database you want to create.

Dialog options

Filename
Type the name of the database. The name should be one that easily reminds you of the 
information in the database, for example BOOKLIB or LIBRARY. As with other Windows 
file names, it cannot have more than eight characters The file extension identifying the 
database, .MDB, is added automatically.

Directories
Select the drive and directory where you want to create the database if it is different 
from the CATBooks directory. In general, we recommend that you do not change the 
directory.

List files of type
Select file type. CATBooks' databases should always have the file extension MDB.

Drives
Select the drive where you want to create the new database.



Dialog Define Browse Layout

In this dialog you specify the fields you want to include in the browse list (window Browse).

Dialog options

List 1
This list displays all fields that are available.

>
Press this button to move the selected field from list 1 to list 2.

<
Press this button to remove the selected field from list 2.

List 2
This list displays the fields you have chosen.

Up
Press this button to move the selected field up one line. You may also do this by pressing
Ctrl+Up arrow, or click on the field and then press Ctrl and hold the mouse-button 
down while you drag.

Down
Press this button to move the selected field down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the field and then press Ctrl and hold the 
mouse-button down while you drag.

Title
You may give the layout a name to make it easier to separate the various layouts in the 
dialog Browse Layout. Maximum length of the title is 40 characters.

Fixed columns
Enter number of fixed columns. Fixed columns are always shown, even when you use 
the scrollbar to view the columns to the right, that may not initially be shown.

OK
Press this button to save changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Width
Here you may enter the width of the selected column. The width is specified as number 
of characters. If you have selected a non proportional font (like Arial) the width is 
calculated on the basis of the average character width.

Font
Press this button to change the font size and/or style, or to choose another font.



Dialog Define Sort Order

In this dialog you choose the fields that you want to use the sort criterion.

Dialog options

List 1
This list displays all fields that are available.

>
Press this button to move the selected field from list 1 to list 2.

<
Press this button to remove the selected field from list 2.

List 2
This list displays the fields you have chosen.

Up
Press this button to move the selected field up one line. You may also do this by pressing
Ctrl+Up arrow, or click on the field and then press Ctrl and hold the mouse-button 
down while you drag.

Down
Press this button to move the selected field down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the field and then press Ctrl and hold the 
mouse-button down while you drag.

Order
Ascending Letters are sorted from A to Z and numbers from 0 to 9.
Descending Letters are sorted from Z to A and numbers from 9 to 0.

Title
You may give the layout a name to make it easier to separate the various layouts in the 
dialog Change Sort Order. Maximum length of the title is 40 characters.

OK
Press this button to save changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

In the summary report, records are first sorted on the fields used in the groups and then on
the fields you specify here.



Dialog Export

Use this dialog to export data to an ASCII-file (a plain text file). The item called <dummy> 
is used to specify that CATBooks should include an empty string in this position (for 
example Title, <dummy> and Author may give this result; "Psycho II", "", "Robert 
Bloch").

Dialog options

Browse
Press this button to specify the file to export to.

Separator
Specify whether CATBooks should use a comma or TAB as the separator.

Subset
Check this if you want CATBooks to only export marked records.

Save
Press this button to save the selected layout.

Clear
Press this button to clear the layout (set to default).

OK
Press this button to start.

Cancel
Press this button to close the dialog.



Dialog Import

Use this dialog when you want to import data from an ASCII-file (a plain text file). The item 
called <dummy> is used to specify that a field from the ASCII-file should not be imported.
All records must be separated by a character-return (if you open the file in a text editor like
Notepad, all records are then shown on a separate line). All text fields must be contained 
within double-quotation marks ("Psycho II"). Logical fields may either be specified as T, Y, -
1, 1 (true) or F, N, 0 (false). Date fields must use the format YYYYMMDD (19960826).
Use the text box Separator authors to specify the separator that is used to separate 
more then one author in the same "field". The different authors are then split and saved 
separately (for example: "Glen A. Larson / Robert Thurston" - use "/" as the separator).
Use the text box Separator keywords to specify the separator that is used to separate 
more then one keyword in the same "field". The different keywords are then split and saved
separately (for example: "Database / Network / Software" - use "/" as the separator).

Dialog options

Browse
Press this button to specify the file to import from.

Separator
Specify whether a comma or TAB is used as separator.

Separator authors
Specify the separator that is used to separate more then one author in the same "field". 
The different authors are then split and saved separately.

Separator keywords
Specify the separator that is used to separate more then one keyword in the same 
"field". The different keywords are then split and saved separately.

Save
Press this button to save the selected layout.

Clear
Press this button to clear the layout (set to default).

OK
Press this button to start.

Cancel
Press this button to close the dialog.



Dialog Merge Databases

In this dialog you specify the database you want to transfer records from. All records in this
database is transferred to the currently open database.

Dialog options

Filename
Enter or select the database you want to transfer the recordssfrom.

Directories
Select the directory where the database is located.

List files of type
Select file type. CATBooks' databases should always have the file extension MDB.

Drives
Select the drive where the database is located.



Dialog Open Database

In this dialog you specify the database you want to open.

Dialog options

Filename
Enter the database you want to open.

Directories
Select the directory where the database is located if it is different from the CATBooks 
directory.

List files of type
Select file type. CATBooks' databases should always have the file extension MDB.

Drives
Select the drive where the database is located if it is different from the CATBooks 
directory.



Dialog Restore Backup

In this dialog you specify where the database you want to restore is located.

Dialog options

Directories
Select the directory where the backup is located.

Drives
Select the drive where the backup is located.

OK
Press this button to accept the selected drive/directory and continue.

Cancel
Press this button to cancel.



Dialog Restore Backup To

In this dialog you specify where you want to restore the database to.

Dialog options

Directories
Select the directory where you want to restore the database to.

Drives
Select the drive where you want to restore the database to.

OK
Press this button to accept the selected drive/directory and start the restore process.

Cancel
Press this button to cancel.



Dialog Save Database As

In this dialog you specify the new name you want to save the database as.

Dialog options

Filename
Type the name of the database. The file extension identifying the database, .MDB, is 
added automatically.

Directories
Select the directory where you want to save the database.

List files of type
Select file type. CATBooks' databases should always have the file extension MDB.

Drives
Select the drive where you want to save the database.



Dialog Split Database

In this dialog you specify the name of the database you want to transfer the marked 
records to.

Dialog options

Filename
Type the name of the database. The file extension identifying the database, .MDB, is 
added automatically.

Directories
Select the directory where the database is located/is to be created.

List files of type
Selelct file type. CATBooks' databases should always have the file extension MDB.

Drives
Select the drive where the database is located/is to be created.

If you have chosen to transfer records to a new database, an existing database with the 
same name will be deleted.



Dialog Transfer Field Names

In this dialog you specify the database you want to transfer the field names from.

Dialog options

Filename
Type the name of the database you want to transfer the field names from.

Directories
Select the directory where the database is located.

List files of type
Select file type. CATBooks' databases should always have the file extension MDB.

Drives
Select the drive where the database is located.



Dialog User-defined Fields

Use this dialog to change the name of the special info fields. You may use these fields to 
store whatever information you need.

Dialog options

OK
Press this button to save changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Transfer
Press this button to transfer field names from another database.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATBooks that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.



Dialog About CATBooks

This dialog displays program information, version number and copyright.



Dialog Preferences

In this dialog you change user preferences.

Dialog options

Data fields/Show fields
Select the fields you want to include in lists (drop-down lists and list boxes) in search 
and report dialogs. By default, none of the special info fields (user-defined fields) are 
selected.

Data fields/Sorting name
Check this if you want names (author) to be displayed using this format: Last name, 
First name when the field is used in the active sort order. This applies to the window 
Browse and reports. In all other cases, names are always displayed using the format 
First name Last name, excluding lookup lists where the last name always is displayed 
first.

Data entry/Sort automatically
Check this if you want CATBooks to automatically update the sort order each time a new
record is saved.

Data entry/Update position in lists automatically
Check this if you want CATBooks to automatically update lookup lists when you activate 
a speed search. This applies to the drop-down lists (for example Company or Format), 
and in all other list boxes that display information from the lookup tables (for example 
when you choose Category from the Lookup menu). Please note that the update 
process may take some time if you have added a lot of items and your machine is not 
that fast. Normally this is not a problem, and we recommend that you check this option.

Data entry/Upper case first character
Check this if you want CATBooks to make the first character in each word upper case as 
you type it. This applies to all data fields, except for the memo fields.

Data entry/New record - test for
Check Author / Title if you want CATBooks to check if you have already added this title 
(based on Author and Title). Check Catalog Number if you want CATBooks to check if 
the Catalog Number already is used when you add a new record. Check ISBN if you 
want CATBooks to check if you have already added this title (based on the-ISBN 
number).

Data entry/Max items drop-down list
Enter the maximum number of items to display simultaneously in a drop-down list that 
shows information from a lookup table. 10 items is displayed by default.

Misc/Use bold font
Check this if you want CATBooks to use a bold font (common in Window 3.1) instead of a
normal font (common in Windows 95) in all windows. You need to re-start CATBooks to 
let this option have effect on the windows Active Record, Memo and Cover. Please note 
that the window Browse uses it's own font that you may change by choosing Browse 
layout from the File menu.

Misc/Use compression - Backup
Check this if you want CATBooks to compress the database when taking backup. When 
using compression the database may occupy as little as ¼ of the original size.

Misc/Use compression - Save pictures
Check this if you want CATBooks to compress the pictures. When using compression 
bitmaps may occupy as little as 1/8 of the original size. Please note that this only affects



new pictures you add. Choose Compress pictures to compress pictures that already 
are in the database.

Misc/Compress pictures
Press this button to compress all pictures in the database.

Misc/Decompress pictures
Press this button to decompress all pictures in the database. Uncheck Use 
compression - Save pictures if you do not want to compress new pictures you add.

Reports/Mono printer
Check this if you want to always print in black and white, no matter what color you have
chosen. This way, you can use colors in the print preview, but not on the print-out.

Reports/Font
Specify the fonts you want to use. These fonts are used by default, but you may override
this in the various reports (by pressing the Page setup button).
Heading Is used on the heading that is printed at the beginning of the first page.
Normal Is used on the rest of the report.

Reports/Margins
Specify the margins that are used by default in all reports. You may override this in the 
various reports (by pressing the Page setup button).
Left Left margin, in inches or centimeters.
Right Right margin, in inches or centimeters.
Top Top margin, in inches or centimeters.
Bottom Bottom margin, in inches or centimeters.

Reports/Units of measurement
Select either centimeters or inches.

Reports/Filter
Select whether you want to use a simple or advanced filter in the reports.

Search/Toolbar
Select the search command you want to activate when you press the search-icon on the 
toolbar.

Search/Show number of records found
Check this if you want CATBooks to show you how many records that were found in the 
last search.

OK
Press this button to save and activate the changes, then close the dialog.

Cancel
Press this button to close the dialog without saving any changes.



Dialog System Information

This dialog gives you the following information:
· Name of the open database
· Number of records (total/marked/deleted)
· CATBooks version
· DOS version
· Windows version
· Memory
· Free system resources (GDI/USER)



Dialog Edit Author

In this dialog you enter information about the author.

Dialog options

Author
Maximum length is 50 characters. We recommend that you use the format Last name, 
First name. The name is then first sorted on last name, then on first name.

Born
Enter the date or year when the author was born.

Dead
Enter the date or year when the author died.

Country
Specify the country where the author is from.

Memo
This field is for comments. You may use up to 32.000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+W when the drop-down list Country has the focus to add a new item to the list.

Press Ctrl+Enter to add a new line to the memo field.

Click with the 'other' mouse-button on the drop-down list to activate a popup-menu with 
these options:
· New Country
· Edit Lookup Table



Dialog Edit Borrower

In this dialog you enter information about the borrower.

Dialog options

Borrower
Maximum length is 50 characters. We recommend that you use the format Last name, 
First name. The name is then first sorted on last name, then on first name.

Address
Type the borrower's address.

Phone
Type the borrower's phone number.

Fax
Type the borrower's fax number

E-mail
Type the borrower's e-mail address.

Memo
This field is for comments. You may use up to 32.000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the address and memo fields.



Dialog Edit Category

In this dialog you enter information about the category.

Dialog options

Category
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Condition

In this dialog you enter information about the condition.

Dialog options

Condition
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Country

In this dialog you enter information about the country.

Dialog options

Country
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Edition

In this dialog you enter information about the edition.

Dialog options

Edition
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Keyword

In this dialog you enter information about the keyword.

Dialog options

Keyword
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Location

In this dialog you enter information about the location.

Dialog options

Location
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Personal Rating

In this dialog you enter information about the rating.

Dialog options

Category
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Printing

In this dialog you enter information about the rating.

Dialog options

Personal Rating
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Publisher

In this dialog you enter information about the publisher.

Dialog options

Publisher
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Puchased Where

In this dialog you enter information about the puchase location.

Dialog options

Puchased Where
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Type

In this dialog you enter information about the type.

Dialog options

Type
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit User-defined

In this dialog you enter information to add to the special info (user-defined) lookup table.

Dialog options

User-defined
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATBooks that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.



Dialog Lookup Author

You use this dialog to edit the lookup table Author. Use the text box to locate the author in 
the list (if he/she already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new author. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new author when you first have 
searched for this author and found out that he/she is not in the database.

Edit
Press this button to edit the selected author.

Delete
Press this button to delete the selected author.

Search
Press this button to search for the author where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Borrower

You use this dialog to edit the lookup table Borrower. Use the text box to locate the person 
in the list (if he/she already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new person to the list. The name you have entered in the text 
box is automatically used. This makes it very easy to add a new person when you first 
have searched for this person and found out that he/she is not in the database.

Edit
Press this button to edit the selected person .

Delete
Press this button to delete the selected person .

Search
Press this button to search for the person where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Category

You use this dialog to edit the lookup table Category. Use the text box to locate the 
category in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new category. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new category when you first have 
searched for this category and found out that it is not in the database.

Edit
Press this button to edit the selected category.

Delete
Press this button to delete the selected category.

Set default
Press this button to specify the selected category as a default value that is automatically
added to all new records.

Search
Press this button to search for the category where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Condition

You use this dialog to edit the lookup table Condition. Use the text box to locate the 
condition in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new condition. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new condition when you first have 
searched for this condition and found out that it is not in the database.

Edit
Press this button to edit the selected condition.

Delete
Press this button to delete the selected condition.

Set default
Press this button to specify the selected condition as a default value that is 
automatically added to all new records.

Search
Press this button to search for the condition where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Country

You use this dialog to edit the lookup table Country. Use the text box to locate the country 
in the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new country. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new country when you first have 
searched for this country and found out that it is not in the database.

Edit
Press this button to edit the selected country.

Delete
Press this button to delete the selected country.

Set default
Press this button to specify the selected country as a default value that is automatically 
added to all new records.

Search
Press this button to search for the country where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Edition

You use this dialog to edit the lookup table Edition. Use the text box to locate the edition in 
the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new edition. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new edition when you first have 
searched for this edition and found out that it is not in the database.

Edit
Press this button to edit the selected edition.

Delete
Press this button to delete the selected edition.

Set default
Press this button to specify the selected edition as a default value that is automatically 
added to all new records.

Search
Press this button to search for the edition where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Keyword

You use this dialog to edit the lookup table Keyword. Use the text box to locate the keyword
in the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new keyword. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new keyword when you first have 
searched for this keyword and found out that it is not in the database.

Edit
Press this button to edit the selected keyword.

Delete
Press this button to delete the selected keyword.

Set default
Press this button to specify the selected keyword as a default value that is automatically
added to all new records.

Search
Press this button to search for the keyword where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Location

You use this dialog to edit the lookup table Location. Use the text box to locate the location 
in the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new location. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new location when you first have 
searched for this location and found out that it is not in the database.

Edit
Press this button to edit the selected location.

Delete
Press this button to delete the selected location.

Set default
Press this button to specify the selected location as a default value that is automatically 
added to all new records.

Search
Press this button to search for the location where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Personal Rating

You use this dialog to edit the lookup table Personal Rating. Use the text box to locate the 
rating in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new rating. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new rating when you first have 
searched for this rating and found out that it is not in the database.

Edit
Press this button to edit the selected rating .

Delete
Press this button to delete the selected rating .

Set default
Press this button to specify the selected rating as a default value that is automatically 
added to all new records.

Search
Press this button to search for the rating where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Printing

You use this dialog to edit the lookup table Printing. Use the text box to locate the printing 
in the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new printing. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new printing when you first have 
searched for this printing and found out that it is not in the database.

Edit
Press this button to edit the selected printing.

Delete
Press this button to delete the selected printing.

Set default
Press this button to specify the selected printing as a default value that is automatically 
added to all new records.

Search
Press this button to search for the printing where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Publisher

You use this dialog to edit the lookup table Publisher. Use the text box to locate the 
publisher in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new publisher. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new publisher when you first have 
searched for this publisher and found out that it is not in the database.

Edit
Press this button to edit the selected publisher.

Delete
Press this button to delete the selected publisher.

Set default
Press this button to specify the selected publisher as a default value that is 
automatically added to all new records.

Search
Press this button to search for the publisher where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Purchased Where

You use this dialog to edit the lookup table Purchased Where. Use the text box to locate the
location in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new location. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new location when you first have 
searched for this location and found out that it is not in the database.

Edit
Press this button to edit the selected location .

Delete
Press this button to delete the selected location .

Set default
Press this button to specify the selected location as a default value that is automatically 
added to all new records.

Search
Press this button to search for the location where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Type

You use this dialog to edit the lookup table Type. Use the text box to locate the type in the 
list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new type. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new type when you first have 
searched for this type and found out that it is not in the database.

Edit
Press this button to edit the selected type.

Delete
Press this button to delete the selected type.

Set default
Press this button to specify the selected type as a default value that is automatically 
added to all new records.

Search
Press this button to search for the type where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup User-defined

You use this dialog to edit the special info (user-defined) lookup table. Use the text box to 
locate the item in the list (if it already is in the database). As you enter the name, the list is
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new item. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new item when you first have 
searched for this item and found out that it is not in the database.

Edit
Press this button to edit the selected item.

Delete
Press this button to delete the selected item.

Set default
Press this button to specify the selected item as default a value that is automatically 
added to all new records.

Search
Press this button to search for the item where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print out a report) before you have told CATBooks that it is in use. You do this by 
selecting File/Preferences and select the fields you are using in the list box called Show 
fields.



Dialog Transfer Lookup Tables

In this dialog you select the lookup tables you want to transfer to the open database.

Dialog options

OK
Press this button to start.

Cancel
Press this button to close the dialog.



Dialog Transfer Lookup Tables From

In this dialog you specify the database you want to transfer the lookup tables from.

Dialog options

Filename
Type the database you want to transfer the lookup tables from.

Directories
Select the directory where the database is located.

List files of type
Select file type. CATBooks' databases should always have the file extension MDB.

Drives
Select the drive where the database is located.



Dialog Author

In this dialog you specify the author(s) of the book. Use the text box to locate the author in 
the list (if he/she is already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

List 1
This list displays all authors in the database.

>
Press this button to move the selected name from list 1 to list 2. You may also press 
Ctrl+Right arrow.

<
Press this button to remove the selected name from list 2. You may also press Ctrl+Left
arrow.

List 2
This list displays the authors you have chosen.

Up
Press this button to move the selected name up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the name and then press Ctrl and hold the mouse-
button down while you drag.

Down
Press this button to move the selected name down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the name and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new author. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new author when you first have 
searched for this author and found out that he or she is not in the database.

Search
Press this button to search for the author where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a artist in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Adjust Value

This dialog lets you adjust the value for all ,or only the marked, records.

Dialog options

Adjust by
Enter the percentage you want to change the value by.

Subset
Check this if you want to adjust the value for only the marked records.

OK
Press this button to start.

Cancel
Press this button to cancel.



Dialog Load Cover

In this dialog you specify the bitmap you want to load and store in the cover field.

Dialog options

Filename
Type the name of the file.

Directories
Select the directory where the files is located.

List files of type
Select file type (bitmaps should always have the extension BMP).

Drives
Select the drive where the file is located.



Dialog Loan Out

Use this dialog when someone borrows a book. Even though CATBooks lets you change the 
name of the borrower from this dialog box, always mark the book as returned before you 
register it as lent out again. This is important if you want the statistics report to be correct.

Dialog options

Borrower
Type the name of the borrower or select it from the drop down list.

Date borrowed
Today's date is automatically used, but you may change this is you want.

Date due
The day the book should be returned to the library, as the latest.

Press Ctrl+W when the drop-down list Borrower has the focus to add a new item to the 
list.

When the book is returned, you can either click the Returned button in the window Active 
Record or choose Loan Transactions/Returned (Show All) from the Record menu. The 
last option shows a list of all books currently on loan, and is preferred when you have many
books you want to register as returned.



Dialog Keywords

In this dialog you specify the keywords you want to link to the record. CATBooks will 
automatically create references to other records based on these keywords. Use the text 
box to locate the keyword in the list (if it is already is in the database). As you enter the 
name, the list is automatically updated. Please note that you must have activated this 
feature in the dialog Preferences (Data entry - Update position in lists automatically).
If not, enter the name and press the Search button.

Dialog options

List 1
This list displays all authors in the database.

>
Press this button to move the selected keyword from list 1 to list 2. You may also press 
Ctrl+Right arrow.

<
Press this button to remove the selected keyword from list 2. You may also press 
Ctrl+Left arrow.

List 2
This list displays the keywords you have chosen.

Up
Press this button to move the selected keyword up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the keyword and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected keyword down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the keyword and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new keyword. The keyword you have entered in the text box is
automatically used. This makes it very easy to add a new keyword when you first have 
searched for this keyword and found out that it is not in the database.

Search
Press this button to search for the keyword that begins with the value you specify. 
Please note that you only need to use this command if you have not checked Data 
entry - Update position in lists automatically in the dialog Preferences. If you have 
checked this option the list is updated automatically as you enter a artist in the text box.

Press Ctrl+1 to activate the text box.



Dialog References

This dialog shows references to other records based on the keywords.

Dialog options

Go to
Go to the selected record.

Close
Close the dialog.



Dialog Returned To Library

Use this dialog when you have many books you want to register as returned. All books 
currently on loan are shown in the list. 
To register books as returned:
1. Select it from the list.
2. Click Returned or double click the item in the list.
3. Repeat step 2 for all the books you want to register as returned.
4. Press Update to update the database and close the dialog.

Dialog options

Returned
Click this button to mark the selected book as returned.

Update
Click this button to update the database and close the dialog.

Cancel
Click this button to cancel any changes and close the dialog.

Sort on
Select the sorting order from this drop-down list (Date due, Title, Catalog Number or 
Borrower).



Dialog Total Value

This dialog displays the total value and the change in value.



Dialog Advanced Search

In this dialog you specify the search criterion you want to base the search on. You can use 
up to 12 fields. You can group the fields in different ways. The search criterion can be saved
to a file for later use. You enter information about the sub-criterion you want to include in 
the query the same way as you do when you use the simple search. You may use the 
logical operator Or to link two fields. Press the button named OR to do this. Two fields that 
are placed on two lines next to each other are grouped by the logical operator AND. You 
add parentheses by clicking on either ( or ).

Dialog options

Add field
Press this button to add a new field (field, operator and value, also called a sub-
criterion).

Edit
Press this button to edit the selected sub-criterion.

Remove
Press this button to remove the selected sub-criterion.

OR
Press this button to add the Or logical operator.

(
Press this button to add a left parenthesis.

)
Press this button to add a right parenthesis.

Up
Press this button to move the selected sub-criterion up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the sub-criterion and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected sub-criterion down one line. You may also do this 
by pressing Ctrl+Down arrow, or click on the sub-criterion and then press Ctrl and 
hold the mouse-button down while you drag.

Search subset
Check this if you want to search only the marked records.

Show all
Check this if you want StampCAT to mark all records found during the search and show 
them (that is, activate the View Subset). Uncheck this if you want StampCATto only 
show the first record found. Then choose Show Next from the Search menu to show 
the next.

OK
Press this button to execute the search.

Cancel
Press this button to close the dialog.

Open
Press this button to open a saved search criterion.

Save
Press this button to save the search criterion.



Save as
Press this button to save the search criterion under a different name.

StampCAT does not distinguish between upper and lower case characters when searching.

Please note that all saved search criterion also can be used as a filter in reports.



Dialog Advanced Search - Sub-criterion

In this dialog you specify the field you want to search in and the value to search for in this 
part of the search criterion. You must also specify the operator that is used to compare the 
value of the field with the value you specified (for example contains, less than or 
between). 
StampCAT supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.

Dialog options

Field values
Press this button to select a field value from the list (this is the same list shown when 
you choose Show Field Values from the Search menu).

OK
Press this button to activate the sub-criterion.

Cancel
Press this button to close the dialog.

StampCAT does not distinguish between upper and lower case characters when searching.



Dialog Cross References

In this dialog you can create cross references between books, authors, directors, publishers
etc. This is an extremely flexible way to search and query data. The result is shown 
immediately on the screen. You may want to print a report or execute a search based on 
the cross references.
It is possible to create cross reference based on up to five fields. The dialog box has five list
boxes that show the result of the cross references. 
Placed right over every list are two drop-down lists. You select field from the left list and 
operator from the right list:

= Is equal to
>= Is greater then or equal to
<= Is less than or equal to

The operator is by default set to =, as this is the most likely choice. 
Please note that in many cases if you want to execute a search based on the cross 
references, you may want to set the operator to >=. This is because StampCAT compares 
the field value with the operator when the search is executed. For example, if you create a 
cross reference between an author and all books he has written, and you want to search for
all these books, you need to select the first book and then choose the operator >= before 
the search is executed. If you do not do this, StampCAT will think you want to search for 
exactly the book that is selected in the list (since the operator was set to =).

See also: Cross References 1 - Author -> Title 
Cross References 2 - Category -> Author -> Title 

Menu options

File/New
Close all cross references and clear all lists.

File/Open
Open saved cross references.

File/Save
Save cross references.

File/Save as
Save cross references under a different name.

File/Close
Close the dialog.

Search/Execute
Execute the search.

Search/Search subset
Check this if you want to search only the marked records.

Search/Show all
Check this if you want StampCAT to mark all records found during the search and show 
them (that is, activate the View Subset command). Uncheck this if you want StampCAT
to only show the first record found. Then choose Show Next from the Search menu to 



show the next.
Report

Press this button to print a report.



Dialog Find

This is the easiest way to search. StampCAT includes only the fields you have entered 
values for in the search. Please note that you need to enter two values for some of the 
fields. For example, if you want to search for books released between 1949 and 1955, you 
enter 1949 and 1955 in the text boxes for year.

Dialog options

Search subset
Check this if you want to search only the marked records.

Show all
Check this if you want StampCAT to mark all records found during the search and show 
them (that is, activate the View Subset command). Uncheck this if you want StampCAT
to only show the first record found. Then choose Show Next from the Search menu to 
show the next.

OK
Press this button to execute the search.

Cancel
Press this button to close the dialog.



Dialog Search Result

This dialog displays the records that were found during the last search.

Dialog options

Go To
Press this button to go to the selected record.

Close
Press this button to close the dialog.



Dialog Show Field Values

In this dialog you specify the field you want to search in with the drop-down list. All unique 
values are shown in the list box. Select the value you want to search for and choose OK. 
The number of occurrences for each value is also shown. This might be very useful for 
statistical purposes.

Dialog options

OK
Press this button to execute the search.

Cancel
Press this button to close the dialog.

Report
Press this button to print a report.

Search
Press this button to search for the first item in the list that begins with the value you 
specify.

Only year
Check this if you want to ignore day and month in date fields.

Sort
Value Sorted by the field value (column 2).
Count Sorted by the number of occurrences (column 1).

Search subset
Check this if you want to search only the marked records.

Show all
Check this if you want StampCAT to mark all records found during the search and show 
them (that is, activate the View Subset command). Uncheck this if you want StampCAT
to only show the first record found. Then choose Show Next from the Search menu to 
show the next.



Dialog Show Field Values - Select Value

This dialog displays the values of the selected field. Instead of entering this yourself, you 
select it from the list.

Dialog options

OK
Press this button to activate the selected value.

Cancel
Press this button to close the dialog.

Report
Press this button to print a report.

Search
Press this button to search for the first item in the list that begins with the value you 
specify.

Only year
Check this if you want to ignore day and month in date fields.

Sort
Value Sorted by the field value (column 2).
Number Sorted by the number of occurrences (column 1).



Dialog Simple Search

In this dialog you specify the field you want to search in and the value to search for. You 
must also specify the operator that is used to compare the value of the field with the value 
you specified (for example contains, less than or between). 
StampCAT supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.

Dialog options

Field values
Press this button to select a field value from the list (this is the same list shown when 
you choose Show Field Values from the Search menu).

Search subset
Check this if you want to search only the marked records.

Show all
Check this if you want StampCAT to mark all records found during the search and show 
them (that is, activate the View Subset command). Uncheck this if you want StampCAT
to only show the first record found. Then choose Show Next from the Search menu to 
show the next.

OK
Press this button to execute the search.

Cancel
Press this button to close the dialog.

StampCAT does not distinguish between upper and lower case characters when searching.



Dialog Advanced Filter

In this dialog you specify the filter criterion used to limit the records printed. You can use 
up to 12 fields. You can group the fields in different ways. The filter criterion can be saved 
to a file for later use. You enter information about the different fields you want to include in 
the query in the same way as you do when you use the simple filter. You may use the 
logical operator Or to link two fields. Press the button named OR to do this. Two fields that 
are placed on two lines next to each other are grouped by the logical operator AND. You 
add parentheses by clicking on either ( or ).

Dialog options

Add field
Press this button to add a new field (field, operator and value, also called a sub-
criterion).

Edit
Press this button to edit the selected sub-criterion.

Remove
Press this button to remove the selected sub-criterion.

OR
Press this button to add the Or logical operator.

(
Press this button to add a left parenthesis.

)
Press this button to add a right parenthesis.

Up
Press this button to move the selected sub-criterion up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the sub-criterion and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected sub-criterion down one line. You may also do this 
by pressing Ctrl+Down arrow, or click on the sub-criterion and then press Ctrl and 
hold the mouse-button down while you drag.

OK
Press this button to activate the filter and close the dialog.

Cancel
Press this button to close the dialog.

Open
Press this button to open a saved filter criterion.

Save
Press this button to save the filter criterion.

Save as
Press this button to save the filter criterion under a different name.

CATBooks does not distinguish between upper and lower case characters in the filter.



The filter criterion is saved as part of the report.



Dialog Advanced Filter - Sub-criterion

In this dialog you specify the field and value you want to base this part of the filter criterion
on. You must also specify the operator that is used to compare the value of the field with 
the value you specified (for example contains, less than or between). 
CATBooks supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.

Dialog options

Field values
Press this button to select a field value from the list (this is the same list that is shown 
when you choose Show Field Values from the Search menu).

OK
Press this button to activate the sub-criterion.

Cancel
Press this button to close the dialog.



Dialog Choose Field

In this dialog you choose the field to add to the report.

Dialog options

OK
Press this button to choose the selected field and close the dialog.

Cancel
Press this button to close the dialog.



Dialog Cover Report

This report prints Title, Author and the Cover picture.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
Test print Check this to only print the first page.

Include
All All records.
Subset Only the subset (that is, records that are marked).
Filter Use a filter to specify what records to print.

New page
Check this if you want each record to be printed on a separate page.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what records to print.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.



Dialog Full Report

This report provides you with a detailed view all information entered about the records. 
Every record is printed on a separate page. You should always disable the page numbering.

See also: Full Report 

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All records.
Subset Only the subset (that is, records that are marked)
Filter Use a filter to specify what records to print.

Memo
Check this to print the memo field.

Filter
Press this button to create a filter that limits what records to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

The report uses all available space on the page (page width minus left and right margin). 
Increase the right margin if you think the report is too "wide".



Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Simple Filter dialog or the 
Advanced Filter dialog when you press the Filter button.



Dialog Heading

In this dialog you enter the heading that is printed at the beginning of the first page. In the 
heading you can use the code <date>, which causes CATBooks to insert the current date. 
This is very useful when a report layout is saved. In the lookup table report you can use the
code <lookup>, to automatically print the name of the lookup table.

Dialog options

OK
Press this button to save the heading and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Alignment
Left justify The heading is left justified.
Center The heading is centered.
Right justify The heading is right justified.



Dialog Insurance Report

This report creates a simple list consisting of Title, Author, Catalog Number, Price and 
Value. Price and value is added up and the total sum is printed at the end of the report.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All records.
Subset Only the subset (that is, records that are marked).
Filter Use a filter to specify what records to print.

Field names
Check this if you want to print the field names at the top of each page.

Ignore decimals
Check this if you want CATBooks to ignore decimals (0 vs. 0.00)

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what records to print.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Simple Filter dialog or the 
Advanced Filter dialog when you press the Filter button.





Dialog Line Report

This report prints one field on each line. You may save the report layout for later use. The 
window title displays the name of the report.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All records.
Subset Only the subset (that is, records that are marked).
Filter Use a filter to specify what records to print.

Field names bold
Check to print the field names in bold.

Right justify field names
Check this to right justify the field names.

Ignore empty fields
Check this if you do not want to print fields that are empty.

Ignore decimals
Check this if you want CATBooks to ignore decimals (0 vs. 0.00)

Keep on same page
Check this if you want CATBooks to keep all the lines from the same record on the same 
page.

Blank line
Check this to print a blank line between each record.

List 1
This list displays all fields that are available.

>
Press this button to move the selected field from list 1 to list 2.

<
Press this button to remove the selected field from list 2.

List 2
This list displays the fields you have chosen.

Up
Press this button to move the selected field up one line. You may also do this by pressing
Ctrl+Up arrow, or click on the field and then press Ctrl and hold the mouse-button 
down while you drag.

Down
Press this button to move the selected field down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the field and then press Ctrl and hold the 
mouse-button down while you drag.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter



Press this button to create a filter that limits what records to print.
Sort

Press this button to change the sort order.
Page setup

Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

New
Press this button to create a new report layout.

Open
Press this button to open a saved report.

Save
Press this button to save the report. Always use lia as file extension.

Save as
Press this button to save the report under a different name.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Simple Filter dialog or the 
Advanced Filter dialog when you press the Filter button.



Dialog List Report

This report prints the fields in columns just like the list in the Browse window. Each record 
may span up to three lines. You may save the report layout for later use. The window title 
displays the name of the report.

See also: Liste Report 

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All records.
Subset Only the subset (that is, records that are marked).
Filter Use a filter to specify what records to print.

Field names
Check this if you want to print the field names at the top of each page.

Ignore decimals
Check this if you want CATBooks to ignore decimals (0 vs. 0.00)

Only year
Check this if you want to ignore the day and month for date fields.

Blank line
Check this to print a blank line between each record.

Line 1/2/3
Indicates what fields that will be printed on each line. The list displays the fields and the 
percentage of the net page width each field will occupy. For example, if the page width 
is 21cm and both left and right margin is set to 1,5cm, net width is 18cm. If you have 
created 3 columns with the fields Title (50%), Author (25%) and Catalog Number 
(25%), this corresponds to column widths of 9cm, 4.5cm and 4.5cm.
Indent Specify the indent from the left margin. Applies only to line 2 and 3.
Right justify Check this if you want to right justify the line. Applies only to line 2 

and 3.
Add field Press this button to add a new field.
Remove Press this button to remove the selected field.
Properties Press this button to edit the selected field's properties.
-> Press this button to move the field to the right.
<- Press this button to move the field to the left.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what records to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the



settings from the dialog Preferences are used.
View file

Press this button to view the ASCII-file when when printing to a file is finished.
New

Press this button to create a new report layout.
Open

Press this button to open a saved report.
Save

Press this button to save the report. Always use lst as file extension.
Save as

Press this button to save the report under a different name.
Print

Press this button to print the report.
Close

Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Simple Filter dialog or the 
Advanced Filter dialog when you press the Filter button.



Dialog Loan Report - By Borrower

Use this report to list all books borrowed grouped by borrower. Select On loan to only 
include books currently on loan. The following fields are included in the report: Borrower, 
Date borrowed, Title, Catalog Number and Date due (if it has not been returned).

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

On loan
Select this option to only include the titles currently on loan.

Filter
Use this option to limit what items to print (based on Borrower). You must specify two 
values; from and to.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Press Ctrl+C to cancel the report.



Dialog Loan Report - By Title

Use this report to list all books borrowed grouped by title. Select On loan to only include 
the books currently on loan. The following fields are included in the report: Title, Author, 
Date borrowed, Catalog Number, Borrower and Date due (if it has not been returned).

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

On loan
Select this option to only include the titles currently on loan.

Filter
Use this option to limit what items to print (based on Title). You must specify two values;
from and to.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Press Ctrl+C to cancel the report.



Dialog Loan Report - On Loan

Use this report to list all books currently on loan. Select Overdue to only include the books
that are overdue. The following fields are included in the report: Title, Author, Catalog 
Number, Borrower and Date due.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Overdue
Select this option to only include the books that are overdue.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Press Ctrl+C to cancel the report.



Dialog Loan Report - Statistics

This report lists the number of times each book has been borrowed. The following fields are
included in the report: Count, Title, Author and Catalog Number.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Press Ctrl+C to cancel the report.



Dialog Page Setup

The page setup dialog lets you specify margins and what fonts to use. You can use one font
for the heading and one for the rest of the report. Default page setup is defined by 
choosing Preferences from the File menu. Settings you make here are used by default, 
but you may override this in the various reports by pressing the Page Setup button. In the
page setup for each report, you may also specify page numbering and columns.

Dialog options

Default fonts and margins
Check this if you want to use the default fonts and margins specified in the dialog 
Preferences.

Font
Heading Is used on the heading that is printed at the beginning of the first page.
Normal Is used on the rest of the report.

Margins
Left Left margin, in inches or centimeters.
Right Right margin, in inches or centimeters.
Top Top margin, in inches or centimeters.
Bottom Bottom margin, in inches or centimeters.

Page number
Check this if you want the pages to be numbered.
Top The page number is printed at the top of the page.
Bottom The page number is printed at the bottom of the page.
Left justify The page number is left aligned.
Center The page number is centered.
Right justify The page number is right aligned.

Columns
Enter number of columns (1 to 5). Please note that when printing to a file, one column is
always used.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.



Dialog Print Preview

This dialog displays the result of the print preview. We cannot guarantee that the print 
preview is 100% accurate. It works best with TrueType fonts. Please note that right justified 
fields not always are placed at the correct position. When printing to the printer everything 
works fine, though.

Dialog options

Zoom
Select the zoom-level (30-200%).

Press this button to view the first page.

Press this button to view the previous page.

Press this button to view the next page.

Press this button to view the last page.
Close

Press this button to close the dialog.



Dialog Properties

In this dialog you set the selected field's properties.

Dialog options

Title
Enter the name to be printed on top of every page. This applies only to the list report, 
not the line report.

Width
Specify the width as a percentage of the net page width (page width minus left and right
margins).

Color
Select a color from this drop-down list.

Bold
Check this if you want CATBooks to print this field in bold.

Upper case
Check this if you want CATBooks to print this field in upper case.

Alignment
The field may be left justified, centered or right justified.

OK
Press this dialog to activate any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.



Dialog Report - Cross References

Use this dialog to print the result of the cross references.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.



Dialog Report - Field Values

Use this dialog to control how the list in the dialog Show Field Values is printed.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.



Dialog Report Lookup Table

This report prints the contents of the specified lookup table. Please note that you may 
enter the code <lookup> in the heading, to automatically print the name of the lookup 
table. This way, you can use the same heading for all lookup tables. For example, if you 
enter "Lookup table <lookup>, printed on <date>" as the heading, CATBooks will 
print "Lookup table Category, printed on 10.25.1996" if you print the table Category on Oct
25, 1996.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Blank line
Check this if you want to print a blank line between each item.

Memo
Check this to print the memo field.

Line-up
Check this to print the members of a group (Applies only to Artist).

Filter
Use this to limit what items to print. You must specify two values; from and to.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.



Dialog Simple Filter

In this dialog you specify the field and value to base the filter on. You must also specify the 
operator that is used to compare the value of the field with the value you specified (for 
example contains, less than or between). 
CATBooks supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.

Dialog options

Field values
Press this button to select a field value from the list (this is the same list that is shown 
when you choose Show Field Values from the Search menu).

OK
Press this dialog to activate any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

CATBooks does not distinguish between upper and lower case characters in the filter.



Dialog Summary Report

This report lets you order data into groups based on fields you select. A group value is 
printed only when the value has changed. The detail line is printed the same way as 
the list report. You may save the report layout for later use.
See also: Summary Report 

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All records.
Subset Only the subset (that is, records that are marked).
Filter Use a filter to specify what records to print.

Ignore decimals
Check this if you want CATBooks to ignore decimals (0 vs. 0.00)

Only year groups
Check this if you want to ignore the day and month for date fields when used in groups.

Only year details
Check this if you want to ignore the day and month for date fields when used in details.

Groups
Select the fields that are used to group the report. The report is always sorted on these 
fields. A group value is printed only when the value has changed.
Color Select the color.
Bold Check this if you want to print the field in bold.
Upper caseCheck this if you want CATBooks to print this field in upper case.
Blank line Check this if you want CATBooks to print a blank line when the group value 

has changed.
Indent Specify the indent from the left margin. Applies only to group 2 and 3.

Details
Indicates what fields that will be printed on the details line. The list displays the fields 
and the percentage of the net page width each field will occupy. For example, if the 
page width is 21cm and both left and right margin is set to 1,5cm, net width is 18cm. If 
you have created 3 columns with the fields Title (50%), Author (25%) and Catalog 
Number (25%), this corresponds to column widths of 9cm, 4.5cm and 4.5cm.
Indent Specify the indent from the left margin. Applies only to line 2 and 3.
Right justify Check this if you want to right justify the line. Applies only to line 2 

and 3.
Add field Press this button to add a new field.
Remove Press this button to remove the selected field.
Properties Press this button to edit the selected field's properties.
-> Press this button to move the field to the right.
<- Press this button to move the field to the left.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.



Filter
Press this button to create a filter that limits what records to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

New
Press this button to create a new report layout.

Open
Press this button to open a saved report.

Save
Press this button to save the report. Always use srt as file extension.

Save as
Press this button to save the report under a different name.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Simple Filter dialog or the 
Advanced Filter dialog when you press the Filter button.



Dialog View File

This dialog displays the contents of the ASCII-file.



Main Windows

CATBooks has five windows that are always visible. The position and size of these windows 
are automatically saved when you exit the program, and is used the next time you run 
CATBooks.
CATBooks 
Active Record 
Memo 
Cover 
Browse 



Window CATBooks

This is CATBooks' main window. You may resize it, and we recommend that you maximize 
it. The other six windows are always displayed within the frame of this window. If you 
minimize it, no other windows are visible. You see the name of the open database in the 
title bar.



Window Active Record

This window contains all fields, execpt for the memo fields and the picture. The window 
may be minimized. If you have resized it and want to set it back to default size, choose 
Reset size from the Window menu.



You can press Ctrl + 1-3 to change the active tab.



Window Memo

This window holds the memo fields. The window may be minimized. If you have resized it 
and want to set it back to default size, choose Reset size from the Window menu.

You can press Ctrl + 1-3 to change the active tab.



Window Cover

This window displays the cover picture you have added to the record. The window may be 
minimized. If you have resized it and want to set it back to default size, choose Reset size 
from the Window menu.



Window Browse

This window shows a list of all records. To view only the subset (that is, only marked 
records), choose Subset from the View menu. To change the browse layout, choose 
Browse Layout from the File menu. The window may be minimized. If you have resized it 
and want to set it back to default size, choose Reset size from the Window menu.



Operators

An operator is used to compare the value of the selected field with the value you specify 
when you search or use a filter when printing reports. CATBooks uses 14 different 
operators. 
If you think this sounds very complicated, you should concentrate on the two most used 
operators: Is equal to and Contains. The number of operators that are available depends 
on the field type (text, date, logical or numeric). 
Here is a list of all operators (the abbreviation is used in the dialogs Advanced Filter and 
Advaced Search):
Is equal to (==) The field must contain exactly the value you specify.
Contains (=) The field must contain the value you specify. Where in the 

field this value is located does not matter. In combination 
with this operator you may also use Wildcards.

Begins with (=*...) The field needs to begin with the value you specify.
End with (=...*) The field needs to end with the value you specify.
Is not equal to (not ==) The field cannot match exactly the value you specify.
Does not contain (not =) The field cannot contain the value you specify. In 

combination with this operator you may also use 
Wildcards.

Does not begin with (not =*...) The field cannot begin with the value you specify.
Does not end with (not =...*)The field cannot end with the value you specify.
Is greater than (>) The field needs to be greater than the value you specify.
Is greater than or equal to (>=) The field needs to be greater or equal to the 

value you specify.
Is less than (<) The field needs to be less than the value you specify.
Is less than or equal to (<=) The field needs to be less than or equal to the value you 

specify.
Is between (between) The field needs to be greater or equal to the first value you

specify and less than or equal to the second value you 
specify.

Is not between (not between) The field needs to be less than the first value you specify
and greater than the second value.



Wildcards

CATBooks supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.
Here are some examples:

Title Begins with "S"

Search for books where the title begins with "S", for example "Santa Claus The Movie" 
or "Science Fiction In the Cinema"

Title does not Begin with "S"

Search for books where the title does not begin with "S".



Statusbar 1
Display the active record's number. The records are numbered according to their position in
the window Browse. The first record is record number 1, the second is record number 2 and
so on. If you are adding a new record, only New is shown until the record is saved.



Statusbar 2
Display the number of records and how many of these that are marked. For example, if you
have entered 340 records and 75 are marked, the statusbar will read 75 / 340.



Statusbar 3
Indicated whether the activate record is marked for deletion or not. To physically remove 
the record from the database, choose Compress from the File menu.



Statusbar 4
This part of the statusbar is used to provide you with information on what is happening 
when a command is activated (for example when you search, or print a report).



Comments
This field is for comments. Maximum length is 32.000 characters.



Synopsis
This field is for the synopsis. Maximum length is 32.000 characters.



Reviews
This field is for reviews. Maximum length is 32.000 characters.



Cover
This field holds the cover picture. Only bitmaps are currently supported.

Bitmap pictures occupy a lot of disk space, but you can have CATBooks compress the 
pictures by choosing Preferences from the File menu and checking Misc. - Use 
compression / Save pictures. When using compression, bitmaps may occupy as little as 
1/8 of the original size.

It may take some time to read the picture from the database. Therefore, if you want to 
browse the database quickly, always minimize the Cover window.



Keywords
You can link up to nine keywords to each record. CATBooks will automatically create 
references to other records based on these keywords. To register the keywords:
1. Click the List button (. . . ). You see the Keywords dialog box.
2. If the keyword is registered in the database, it is already listed. To find the 

keyword, either scroll through the list and select the keyword you want, or type it (or 
the first characters) in the text box above the list. Click the Add ( > ) button to move 
the keyword to the right-most list box.
If the keyword is not registered in the database, choose New. You see the New 
Keyword dialog box. Fill in the information you need. When you are ready, choose OK 
to close the dialog box.

3. Choose OK to close the Keywords dialog box. You see the keywords in the Keyword 
field in the Keywords window.



Browse
The list shows a list of all records. To view only the subset (that is, only marked records), 
choose Subset from the View menu. To change the browse layout, choose Browse 
Layout from the File menu.

If you are not satisfied with the width of the columns, you can resize the columns by 
dragging the separators.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· Layout
· Font
· Fixed columns
· Change Sort Order



User-defined 1
This is a text field with a maximum length of 50 characters.



User-defined 2
This is a text field with a maximum length of 50 characters.



User-defined 3
This is a text field with a maximum length of 50 characters.



User-defined 4
This is a text field with a maximum length of 50 characters.



User-defined 5
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 5 from the 
Lookup menu to edit this list.

Press Ctrl+W when the list has the focus to add a new item.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New User-defined 5
· Edit Lookup Table



User-defined 6
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 6 from the 
Lookup menu to edit this list.

Press Ctrl+W when the list has the focus to add a new item.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New User-defined 6
· Edit Lookup Table



User-defined 7
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 7 from the 
Lookup menu to edit this list.

Press Ctrl+W when the list has the focus to add a new item.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New User-defined 7
· Edit Lookup Table



User-defined 8
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 8 from the 
Lookup menu to edit this list.

Press Ctrl+W when the list has the focus to add a new item.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New User-defined 8
· Edit Lookup Table



User-defined 9
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 10
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 11
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 12
This is a date field. If the day, month or year has only one digit type a zero ( 0 ) before the 
numeral; for example, 06.02.97.



User-defined 13
This is a numeric field.



Title
Enter the title of the book. CATBooks can handle up to 100 characters.



Original title
Enter the original title (if applicable). CATBooks can handle up to 100 characters.



Author
The author(s) of the book. We recommend that you use the format Last name, Fist name
(for example MacLean, Alistair). To catalog the author(s):
1. Click the List button (. . . ). You see the Author dialog box.
2. If the author is registered in the database, the name is already listed. To find the 

author, either scroll through the list and select the name you want, or type the name 
(or the first characters in the name) in the text box above the list. Click the Add ( > ) 
button to move the name to the right-most list box.
If the author is not registered in the database, choose New. You see the New 
Author dialog box. Fill in as much of the information as you want. You can use the 
Memo field to add personal comments. When you are ready, choose OK to close the 
dialog box.

3. Choose OK to close the Author dialog box. You see the name(s) in the Author field.



Publisher
The publisher that released the book. Type the name or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new publisher.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Publisher
· Edit Lookup Table



Country
The country of origin. Type the name or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new country.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Country
· Edit Lookup Table



Condition
The physical condition of the book. Select one of the pre-defined descriptions from the list 
or define your own condition as follows: 
1. From the Lookup menu choose Condition.
2. Delete the items you do not need. To do this, select the item you want to delete and 

choose Delete.
3. To add a new description, choose New and complete the information requested in the 

dialog box. 

Press Ctrl+W when the list has the focus to add a new condition.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Condition
· Edit Lookup Table



Category
The category describes the book, for example Adventure, Hobby, Science fiction or Travel. 
You can select one of the pre-defined descriptions from the list or define your own category
as follows: 
1. From the Lookup menu choose Category. 
2. Delete the items you do not need. To do this, select the item you want to delete and 

choose Delete.
3. To add a new description, choose New and complete the information requested in the 

dialog box. 

Press Ctrl+W when the list has the focus to add a new category.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Category
· Edit Lookup Table



Type
Enter the physical type of book, for example Hard cover, Paperback or Soft cover. You can 
select one of the pre-defined descriptions from the list or define your own type as follows: 
1. From the Lookup menu choose Type. 
2. Delete the items you do not need. To do this, select the item you want to delete and 

choose Delete.
3. Choose New and complete the information requested in the dialog box.

Press Ctrl+W when the list has the focus to add a new type.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Type
· Edit Lookup Table



Location
Where the book is located. Type the location or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new location.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Location
· Edit Lookup Table



Purchased
The date you purchased the book. If the day, month or year has only one digit type a zero (
0 ) before the numeral; for example, 06.02.1997.



Registered
The registration date. Todays date is used automatically but you can change it if you want.



Year
Enter the year the book was released.



Edition
The book's edition. Type the edition or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new edition.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Edition
· Edit Lookup Table



Printing
Information about printing. Type it or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new printing.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Printing
· Edit Lookup Table



Page
The starting page. This is usually 1 (entered automatically). Use this field if you want to 
store information about magazine or newspaper articles.



Pages
Enter the number of pages.



ISBN
Enter the ISBN-number (if applicable).



Catalog Number
Use this field if you have your own system for identifying books in your collection.



Price
The purchase price. You can decide, for example, if this refers to the price you actually paid
for the book or the retail purchase price if it is different.



Value
Current value of the book, for example the collectors value.



Change in value
The difference between price and value.



Loan
You use the loan module to keep track of books on loan.
Press the Loan Out to register a book as 'on loan'. Press the Returned button to register a
book as returned. The Borrower field shows who is borrowing the book. The Date field 
shows when the book was borrowed and the Date due field shown the date the book is 
due to be returned.

Even though CATBooks lets you change the name of the borrower from the Loan Out dialog
box, always mark the book as returned before you register it as 'on loan' again. This is 
important if you want to statistics report to be correct.

When the book is returned, you can either click the Returned button in the window Active 
Record or choose Loan Transactions / Returned (Show All) from the Record menu. 
The last option shows a list of all books currently on loan, and is preferred when you have 
many books you want to register as returned.



Sort By
Use this field to specify the text that is used when you sort on Title. For example, if the title
is 'The Ghost of Flight 401' specify 'Ghost of Flight 401, The'. This is done automatically if 
this field is empty when you leave the Title field.



Personal Rating
Your own personal rating, for example Excellent, Good or Mediocre. Type the rating or 
select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new item.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Personal Rating
· Edit Lookup Table



Purchased Where
Specify where you purchased the book. Type the name or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new item.

CATBooks does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Purchased Where
· Edit Lookup Table



File extensions report files

lin line report
lis list report
sum summary report



Procedures

In this section some of the most important procedures (for example how to create a 
database or how to search) are explained in details. Most of these examples are referring 
to the sample database (SAMPLE.MDB) that was copied to the same directory as 
CATBooks during installation.

Create New Database 
Open Database 
Backup 
Restore Backup 
Change Browse Layout 
Change Sort Order 
Transfer Lookup Tables 
Change User Defined Field Names 
Add New Record 
Delete Record 
Find 
Simple Search 
Cross References 1 - Author -> Title 
Cross References 2 - Category -> Author -> Title 
Full Report 
List Report 
Summary Report



Create New Database

A database is one physical file containing a set of related data tables. All information you 
enter about an record is stored in the same database. You may, however, have as many 
databases as you like. This way you can split your collection in different databases. Existing
databases can later be merged. Each database you create has a corresponding ini-file with 
the same name as the database (for example BOOKLIB.MDB and BOOKLIB.INI). This ini-
file contains information about the browse layout and sort order.
The first you need to do after you have started CATBooks, is to open a database. You can 
do this by either open an existing database or create a new. The database that was opened
when you exited the program, is automatically opened the next time you start it.
Follow these steps to create a new database:
1. From the File menu choose New. You see the Create New Database dialog box.
2. Select the drive and directory where you want to create the database if it is different 

from the CATBooks directory. In general, we recommend that you do not change the 
directory.

3. In the File Name text box type the name of the database. The name should be one 
that easily reminds you of the information in the database, for example BOOKLIB or 
LIBRARY. As with other Windows file names, it cannot have more than eight characters. 
The file extension identifying the database, .MDB, is added automatically.

4. Choose OK.

Most of the lookup tables in a new database are empty. From the Lookup menu, choose 
Transfer to transfer the contents of one or more lookup tables from another database. For 
more information on this, see Transfer Lookup Tables.



Open Database

Follow these steps to open a database:
1. From the File menu, choose Open.
2. In the Directories list box, select the drive and directory where the database is 

located if it is different from the CATBooks directory.
3. From the list box of database names, select the database you want to open and choose

OK or double-click the name.

We recommend that you open the sample database (SAMPLE.MDB) the first time you run 
CATBooks. Most examples in the documentation are referring to this database.



Backup

You create a backup copy of the open database by following these steps:
1. Choose Backup from the File menu.
2. Specify the drive and directory to copy the database to, this is usually root on drive A.
3. Press the OK button and follow the instruction on the screen.

To protect against hard disk failure, you should routinely backup your valuable data files. 
FNProgramvare has no responsibility for any loss of data.



Restore Backup

You may restore a backup by following these steps:
1. Choose Restore from the File menu.
2. Specify the drive and directory where the backup is located, this is usually root on 

drive A.
3. Press the OK button.
4. Specify the drive and directory where the database is to be copied to.
5. Insert diskette number 1 (with the file "dbname".001) into your diskette drive.
6. Press the OK button and follow the instruction on the screen.

The files are now copied to the hard disk and merged to one database.



Change Browse Layout

The window "Browse" displays a list of all records (or only marked records, if you have 
checked Subset in the View menu). By default Title, Author and Year are shown, but 
you may define up to 5 browse layouts yourself.
Let us now change the browse layout to Title, Author, Category and Catalog Number:
1. Choose Browse Layout from the File menu. You may also click with the 'other' 

mouse-button on the list and select Layout from the popup-menu.
2. Select User defined 1.
3. Press the Edit button.
4. Select Title, Author, Category and Catalog Number from the left list box. The fields

you have chosen are now displayed in the right list box.
5. Enter a title, for example Title/Author/Catg/ID.
6. By default the font MS Sans Serif (10 points) is used. If you want to change this, 

press the Font button.
7. Press the OK button. You are returned to the dialog Browse Layout.
8. Press the OK button to activate this layout.
9. If you are not satisfied with the width of the columns, you can resize the columns by 

dragging the separators.



Change Sort Order

By default the records are sorted on Title. You may however define up to 5 sort criteria 
yourself.
Let us now define a sort criteria based on Category and Title:
1. Choose Change Sort Order from the File menu.
2. Select User Defined 1.
3. Press the Edit button.
4. Select Category and Title from the left list box. The fields you have chosen are now 

displayed in the right list box.
5. Enter a title, for example Category/Title.
6. Press the OK button. You are returned to the dialog Change Sort Order .
7. Press the OK button to activate this sort criterion.



Transfer Lookup Tables

CATBooks uses a relational database model. This means that you enter most information 
only once. For example, you enter an author's name only the first time you add a book 
written by this author. Later you simply choose this name from a list. CATBooks stores the 
information in "lookup tables". The result is that you save time and avoid typing errors. The
database occupies less space and it is easier to search for exactly the information you 
want.
The items in the lookup tables in a database is only accessible from within this database. If 
you work with several databases, you may want to transfer one or more tables from 
another database.
Follow these steps to transfer the lookup tables from another database:
1. Choose Transfer from the Lookup menu.
2. Specify the database you want to transfer the tables from.
3. Press the OK button.
4. Select the tables you want to transfer.
5. Press the OK button to start.



Change User Defined Field Names

In addition to the standard fields, you can define up to thirteen fields for special 
information. These fields are ready to use, but you may want to change the field names to 
something more specific (the default names are User-defined 1, User-defined 2 and so on).
Follow these steps to change the names of the special fields (user-defined fields):
1. From the File menu choose User-defined Fields. You see the User-defined Fields 

dialog box.
2. In the text boxes available, type the titles of the special fields, for example 'Store', 

'Borrowed by' or 'For sale'. Ensure that the field number corresponds to the type of 
field you want the special category to be. For example, the 'For sale' field should be a 
check box.

3. Choose OK.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATBooks that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.



Add New Record

Follow these steps to add a new record:
1. Choose New from the Record menu.
2. Enter relevant information in these windows: Active Record and Memo.
3. CATBooks automatically saves the information the moment you leave the Active 

Record window to choose another command. You can also save the information by 
choosing Save from the Record menu.



Delete Record

When you delete records as explained below, CATBooks will also compress your database 
to save hard disk space:
1. If you do not see the Browse window, open it by double-clicking the Browse icon at 

the bottom of the main window. You may also press Ctrl+B.
2. From the list of registered records, select the record you want to delete.
3. From the Record menu choose Delete / Active record. You see the word DELETED in 

the status bar. Repeat for the other records you want to delete (if any).
4. From the File menu choose Compress. The system asks if you want to delete the 

record(s). Click Yes.



Find

Let us now execute a search, and let CATBooks show us all records found directly.
Here is an example that shows you how to find books in the category Hobby (please open 
the sample database, SAMPLE.MDB, first):
1. Choose Find from the Search menu.
2. Select Hobby from the Category drop-down list.
3. Uncheck Search subset. We want to search all records, no matter whether they are 

marked or not.
4. Check Show all. We want CATBooks to mark all records found and then show these 

(that is, show the subset).
5. Press the OK button to execute the search.



Simple Search

Here is an example that shows you how to search for books released in USA (please open 
the sample database, SAMPLE.MDB, first):
1. Choose Simple Search from the Search menu.
2. Select Country from the first drop-down list (this is the field).
3. Select Is equal to from the next drop-down list (this is the operator).
4. Enter USA (or select it from the list) as the value to search for.
5. Uncheck Search subset. We want to search all records, no matter whether they are 

marked or not.
6. Uncheck Show all. We want to show one record at first and later choose Show Next 

from the Search menu. This is faster since CATBooks does not need to mark all 
records that are found.

7. Press the OK button to execute the search.



Cross References 1 - Author - > Title

Here we will create cross references between Author and Title (please open the sample 
database, SAMPLE.MDB, first).
1. Choose X-Ref from the Search menu.
2. Select Author from the drop-down list to the left.
3. Select Title from the drop-down list over the second list box. All books written by the 

author selected in the left-most list are shown.
4. Try to select a different author and watch CATBooks update the list with book titles.
5. Select MacLean, Alistair in the list to the left.
6. To execute a search based on this cross reference, first select the first record shown in 

the second list box (The Golden Gate).
7. Select the operator >= (Is greater then or equal to) from the second operator drop-

down list.
8. Uncheck Search subset in the Search menu. We want to search all records, no 

matter whether they are marked or not.
9. Check Show all in the Search menu. We want CATBooks to mark all records found 

and then show these (that is, show the subset).
10. Choose Execute from the Search menu to execute the search.



Cross References 2 - Category -> Author -> Title

Here we will create cross references between Category, Author and Title (please open 
the sample database, SAMPLE.MDB, first).
1. Choose X-Ref from the Search menu.
2. Select Category from the drop-down list to the left.
3. Select Author from the drop-down list over the second list box.
4. Select Title from the drop-down left over third list box.
5. Try to select a different category or author and watch how the list with book titles is 

updated.
6. Select Adventure in the list to the left list, and Tolkien, J. R. R. in the second list box.
7. Let us execute a search based on this cross reference.
8. Uncheck Search subset in the Search menu. We want to search all records, no 

matter whether they are marked or not.
9. Check Show All in the Search menu. We want CATBooks to mark all records found 

and then show these (that is, show the subset).
10. Choose Execute from the Search menu to execute the search.



Full Report

This report provides you with a detailed view all information entered about a record. Let us 
print all books in the category Hobby (please open the sample database, SAMPLE.MDB, 
first):
1. Choose Full from the Report menu.
2. We want a print preview, select Print to/Screen.
3. To only print books in the category Hobby, press the Filter button and specify the 

following filter criterion: Category    Is equal to    Hobby. Press the OK button to 
activate this filter. CATBooks selects Include/Filter automatically.

4. Press the Print button to print.
5. When you close the report window all options are saved, and are automatically loaded 

next time you select this report.

You print a full report of the activate record by clicking  on the toolbar.

The report uses all available space on the page (page width minus left and right margin). 
Increase the right margin if you think the report is too "wide".



List Report

We will now try to print a list of Author, Title, Year and Catalog Number (please open 
the sample database, SAMPLE.MDB, first):
1. Choose List from the Report menu.
2. Press the New button to create a new report layout.
3. We want a print preview, select Print to/Screen.
4. We want to print all records, select Include/All.
5. Select Line 1, press the Add field button and select Author from the list. Press Add 

field and select Title, Add field and Year, and finally Add field and Catalog 
Number.

6. If you are not satisfied with the width of the columns, you can resize the columns by 
dragging the separators.

7. Uncheck Field names.
8. Press the Sort button. Specify Author and Title as the sort field and press the OK 

button.
9. Press the Save button to save the report layout.
10. Press the Print button to print.



Summary Report

In this example we will create a summary report grouped by Category, and place Title, 
Author and Catalog Number on the details line (please open the sample database, 
SAMPLE.MDB, first):
1. Choose Summary from the Report menu.
2. Press the New button to create a new report layout.
3. We want a print preview, select Print to/Screen.
4. We want to print all records, select Include/All.
5. Select Groups and select Category from the first drop-down list.
6. Select Details and enter 0,50 as Indent.
7. Title, Author and Catalog Number are to be printed on the details line. Press the 

Add field button and select Title, then Add field and select Author, then Add field 
and Catalog Number.

8. If you are not satisfied with the width of the columns, you can resize the columns by 
dragging the separators.

9. Press the Save button to save the report layout.
10. Press the Print button to print.



Tips

Go To Record
Reports - Fonts
Show Fields 



Go To Record

When you choose Go to from the Record menu, CATBooks executes this search based on 
the active sort order. If you specify a value that does not exist, CATBooks searches for the 
first record where the field begins with this value. If the first field in the sort order is not the
same you are searching in, the result may not be what you expect. For example, if the 
records are sorted by Author and you choose Go to Record by Title and enter "H", 
CATBooks searches for the first record from the top of the list in the "Browse" window 
where the title begins with "H". 



Reports - Fonts

This first time CATBooks is run, the first font installed on the printer (as it is returned by 
Windows) is set to the default font. If you are not satisfied with this font, simply choose 
Preferences from the File menu, then Report and select another font. You can use one 
font for the heading and one for the rest of the report. Settings you make in the dialog 
Preferences are used by default, but you may override this in the various reports by 
pressing the Page Setup button.



Show Fields

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATBooks that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.
To change what fields to show in lists, to the following:
1. Choose Preferences from the File menu.
2. In the list box Show fields select the fields you are using.
3. Press the OK button to save and activate the changes.
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Starting CATBooks

Double-click the CATBooks icon. You see the CATBooks main window. 

In CATBooks, the windows you use most often are always available as icons at the bottom 
of the main window. To open a window, double-click the icon. You may also open a window 
by choosing from the Window menu or pressing the menu shortcut (for example Ctrl+B to
open the Browse window). When you no longer need a window, minimize it.
When you start CATBooks for the first time, you see the Browse window (if you do not see 
it, double-click the Browse icon at the bottom of the main window). The Browse window 
contains the records from the sample database included with CATBooks (this database is 
called SAMPLE.MDB). 
Before you can start cataloging your collection, you must create your own database. 
CATBooks enables you to have several databases so you can split your collection in 
different segments. Separate databases can later be merged.



Creating a database

1. From the File menu choose New. You see the Create New Database dialog box.
2. Select the drive and directory where you want to create the database if it is different 

from the CATBooks directory. In general, we recommend that you do not change the 
directory.

3. In the File Name text box type the name of the database. The name should be one 
that easily reminds you of the information in the database, for example BOOKLIB or 
LIBRARY. As with other Windows file names, it cannot have more than eight characters. 
The file extension identifying the database, .MDB, is added automatically.

4. Choose OK. 
The database is open and you can now begin adding information to it. You see the name of 
the database in the title bar of the CATBooks window. 
If you want to organize your collection using only one database, then you dont have to 
think about databases again. CATBooks will always open this database when you start the 
application. If, however, you choose to organize your collection in a way that requires 
several databases, follow the steps above to create as many as you need. To switch from 
one database to another, see Opening a database. 



Opening a database

Whenever you start CATBooks the system will automatically open the last database you 
worked with. If you have more than one database and want to change, follow the steps 
below:
1. From the File menu, choose Open.
2. In the Directories list box, select the drive and directory where the database is 

located if it is different from the CATBooks directory.
3. From the list box of database names, select the database you want to open and choose

OK or double-click the name.

If you do not exit the program by choosing Exit from the File menu (or Close from the 
main window's Control menu), for example if a system error occurs or there is a power-
failure, you may get an error message the next time you try to open the database 
(probably error 3049). If this happens, run a utility called FIX that was installed to the same
directory as CATBooks.



Cataloging Your Collection

If you havent already done so, create a database (see Creating a database). Otherwise, 
make certain the database you want to work with is open (see Opening a database).
When you type information, CATBooks can automatically make the first letter in each word 
uppercase. If you want to use this feature:
1. From the File menu choose Preferences.
2. In the Preferences dialog box, choose Data Entry.
3. Ensure that the option Uppercase first character is checked (marked with an X).
4. Choose OK.



Adding a record

To add a new record to your catalog, choose New from the Record menu. You see the 
Active Record window. Note the following:
· Since adding a record is something you do often, CATBooks makes this window 

available to you at any time. The window is always visible and can be minimized and 
reduced to an icon but not closed. 

· CATBooks automatically saves the information the moment you leave the Active 
Record window to choose another command. You can also save the information by 
choosing Save from the Record menu.

· If you want to examine another record, select the record in the Browse window. If it is 
minimized, double-click the Browse icon at the bottom of the main window or press 
Ctrl+B.

Fill in the fields as explained below. Most information you need to enter only once. For 
example, an author's name is included in the catalog the first time you add a book written 
by this author. Later, you simply choose this name from a list.

Title Enter the title of the book. CATBooks can handle up to 100 characters.

Author The author(s) of the book. We recommend that you use the format Last 
name, Fist name (for example MacLean, Alistair). To catalog the 
author(s):
1. Click the List button (. . . ). You see the Author dialog box.
2. If the author is registered in the database, the name is already 

listed. To find the author, either scroll through the list and select the 
name you want, or type the name (or the first characters in the name) 
in the text box above the list. Click the Add ( > ) button to move the 
name to the right-most list box.
If the author is not registered in the database, choose New. You 
see the New Author dialog box. Fill in as much of the information as 
you want. You can use the Memo field to add personal comments. 
When you are ready, choose OK to close the dialog box.

3. Choose OK to close the Author dialog box. You see the name(s) in the 
Author field.

Year Enter the year the book was released.

Catalog
Number Use this field if you have your own system for identifying books in your 

collection.

Sort By Use this field to specify the text that is used when you sort on Title. For 
example, if the title is 'The Ghost of Flight 401' specify 'Ghost of Flight 
401, The'. This is done automatically if this field is empty when you leave 
the Title field.

Original Title Enter the original title (if applicable). CATBooks can handle up to 100 
characters.



Publisher The publisher that released the book. Type the name or select it from the 
drop-down list.

Country The country of origin. Type the name or select it from the drop-down list.

Condition The physical condition of the book. Select one of the pre-defined 
descriptions from the list or define your own condition as follows: 
1. From the Lookup menu choose Condition.
2. Delete the items you do not need. To do this, select the item you want 

to delete and choose Delete.
3. To add a new description, choose New and complete the information 

requested in the dialog box. 

Category The category describes the book, for example Adventure, Hobby, Science 
fiction or Travel. You can select one of the pre-defined descriptions from 
the list or define your own category as follows: 
1. From the Lookup menu choose Category. 
2. Delete the items you do not need. To do this, select the item you want 

to delete and choose Delete.
3. To add a new description, choose New and complete the information 

requested in the dialog box. 

Type Enter the physical type of book, for example Hard cover, Paperback or Soft
cover. You can select one of the pre-defined descriptions from the list or 
define your own type as follows: 
1. From the Lookup menu choose Type. 
2. Delete the items you do not need. To do this, select the item you want 

to delete and choose Delete.
3. Choose New and complete the information requested in the dialog 

box.

Edition The book's edition. Type the edition or select it from the drop-down list.

Printing Information about printing. Type it or select it from the drop-down list.

Page The starting page. This is usually 1 (entered automatically). Use this field 
if you want to store information about magazine or newspaper articles.

Pages Enter the number of pages.

ISBN Enter the ISBN-number (if applicable).

Keywords You can link up to nine keywords to each record. CATBooks will 
automatically create references to other records based on these keywords.
To register the keywords:
1. Select the Basic tab in the window Active Record.
2. Click the List button (. . . ). You see the Keywords dialog box.
3. If the keyword is registered in the database, it is already listed. 

To find the keyword, either scroll through the list and select the 



keyword you want, or type it (or the first characters) in the text box 
above the list. Click the Add ( > ) button to move the keyword to the 
right-most list box.
If the keyword is not registered in the database, choose New. 
You see the New Keyword dialog box. Fill in the information you need. 
When you are ready, choose OK to close the dialog box.

4. Choose OK to close the Keywords dialog box. You see the keywords in 
the Keyword field.

Purchased The date you purchased the book. If the day, month or year has only one 
digit type a zero ( 0 ) before the numeral; for example, 06.02.1997.

Purchased 
Where Specify where you purchased the book. Type the name or select it from 

the drop-down list.

Price The purchase price. You can decide, for example, if this refers to the price 
you actually paid for the book or the retail purchase price if it is different.

Value Current value of the book, for example the collectors value. 

Location Where the book is located. Type the location or select it from the drop-
down list.

Personal
Rating Your own personal rating, for example Excellent, Good or Mediocre. Type 

the rating or select it from the drop-down list.

Registered The registration date. Todays date is used automatically but you can 
change it if you want.

Comments This field is for comments. Maximum length is 32.000 characters.

Synopsis This field is for the synopsis. Maximum length is 32.000 characters.

Reviews This field is for reviews. Maximum length is 32.000 characters.

Special info In addition to the standard fields, you can define up to thirteen fields for 
special information. These fields are ready to use, but you may want to 
change the field names to something more specific (the default names are
User-defined 1, User-defined 2 and so on). To name a special field:
1. At the bottom of the CATBooks window, double-click the icon for Active

Record or press Ctrl+H. You see the Active Record window with the 
thirteen special information fields. There are four text fields (maximum
50 characters), four drop-down list fields, three check-box fields, one 
date field and one numeric field.

2. From the File menu choose User-defined Fields. You see the User-
defined Fields dialog box.

3. In the text boxes available, type the titles of the special fields, for 
example 'Store', 'Borrowed by' or 'For sale'. Ensure that the field 
number corresponds to the type of field you want the special category 
to be. For example, the 'For sale' field should be a check box.



4. Choose OK.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATBooks that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.
You have now completed the cataloging of this book. CATBooks automatically saves the 
information the moment you leave the Active Record window to choose another command. 
You can also save the information by choosing Save from the Record menu.
You can now:
· add another record
· work with information about an existing record. You choose the record you want to 

work with in the Browse window. To activate this window, double-click the Browse icon 
or press Ctrl+B.



About lookup tables

CATBooks uses a relational database model. This means that you register most information 
only once. For example, an author's name is included in the catalog the first time you add a
book written by this author. Later, you simply choose this name from a list. CATBooks 
stores the information in "lookup tables". The result is that you save time and avoid typing 
errors. The database occupies less space and it is easier to search for exactly the 
information you want.
CATBooks uses the following lookup tables: Author, Borrower, Category, Condition, 
Country, Edition, Keyword, Location, Personal Rating, Publisher, Printing, 
Purchased Where, Type and the four user-defined fields that are linked to lookup tables 
(User-defined 5, User-defined 6, User-defined 7 and User-defined 8).
In all lookup tables you may add comments to every item. You can print a report by 
choosing Lookup from the Report menu.
For most of the fields linked to lookup tables you select a value by choosing from a drop-
down list (for example Publisher and Category). You can also enter the value directly, 
just like an ordinary text field. If this value is not already in the database, CATBooks adds it 
automatically. You can press Ctrl+W to add a new item, or click inside the field with the 
'other' (in most cases the right) mouse button to activate a popup menu and choose New 
from this menu. For the fields Author and Keyword, you press the button with the three 
dots, and then select the author/keywords in a dialog box.
Transferring Lookup Tables

The items in the lookup tables in a database is only accessible from within this database. If 
you work with several databases, you may want to transfer one or more tables from 
another database. You do this by choosing Transfer from the Lookup menu. Specify the 
database to transfer from and select the tables that you want to transfer.



Editing a record

1. If you do not see the Browse window, open it by double-clicking the Browse icon at 
the bottom of the main window. You may also press Ctrl+B.

2. From the list of registered records, double-click the record you want to work with. You 
see the Active Record window.

3. Change the information as necessary.
CATBooks automatically saves the information the moment you leave the Active Record 
window to choose another command. You can also save the information by choosing Save 
from the Record menu.



Deleting records and compressing your database

When you delete records as explained below, CATBooks will also compress your database 
to save hard disk space:
1. If you do not see the Browse window, open it by double-clicking the Browse icon at 

the bottom of the main window. You may also press Ctrl+B.
2. From the list of registered records, select the record you want to delete.
3. From the Record menu choose Delete / Active record. You see the word DELETED in 

the status bar. Repeat for the other records you want to delete (if any).

This only marks the record(s) for deletion. To actually remove the records from your hard 
disk, you must compress the database as explained in the next step. 

4. From the File menu choose Compress. The system asks if you want to delete the 
record(s). Click Yes.



Cataloging book covers

CATBooks lets you save and display bitmap pictures your book covers (or any other picture 
you might want to store). Bitmap pictures occupy a lot of disk space, but you can have 
CATBooks compress the pictures by choosing Preferences from the File menu and 
checking Misc. - Use compression / Save pictures. When using compression, bitmaps 
may occupy as little as 1/8 of the original size.

To add a bitmap picture to CATBooks:

1. Scan the picture and save it as a .BMP file or place it on the clipboard.
2. In CATBooks, choose the record from the Browse window.
3. To add a bitmap picture from a .BMP file: From the Edit menu choose Load 

Cover. You see the dialog box Load Cover. Select the bitmap file and choose OK. 
CATBooks opens the Cover window and places the picture in the window.
To add a bitmap picture from the clipboard: Open the Cover window by double-
clicking the icon at the bottom of the main window. You may also press Ctrl+R. Then 
choose Paste from the Edit menu. CATBooks places the bitmap picture in the window.

To display a picture:

1. Choose the record from the Browse window.
2. Open the Cover window by double-clicking the icon at the bottom of the main window. 

You may also press Ctrl+R. You see the bitmap picture in the window.

It may take some time to read the picture from the database. Therefore, if you want to 
browse the database quickly, always minimize the Picture window.

To remove a bitmap picture:

Open the Cover window and choose Cut from the Edit menu.



Marking records

CATBooks uses a system of marking records. Marking and unmarking records can be useful 
if you want to select different records based on some sort of criteria (for example, all 
paperbacks) for a pending action. You may view, edit, search among or even print only the 
records that are marked. You can either mark records manually or let CATBooks mark the 
records based on a search result.
All new records you add to your database are automatically marked. The button that looks 
like a "V" on the toolbar indicates whether the record is marked or not. You mark/unmark 
the active record simply by pressing this button. When the record is marked the button is 
"in" (pressed) and when the record is unmarked the button is "out" (released). You can also 
press Ctrl+M to mark/unmark.
The status bar always shows the number of records in the database, and how many of 
these that are marked. For example, if you have entered 340 records and 75 are marked, 
the status bar reads 75 / 340.



Viewing marked records only 

By default CATBooks shows all records entered into your database. Use the menu choice 
Subset from the View menu to show only the records that are marked. This is very useful 
when you want to look at just some of the records you have entered (for example books 
published by Fawcett Publications).



Changing the layout of the Browse window

You can decide which fields that should be displayed in the Browse window. By default 
Title, Author and Year are displayed.
You may define up to five browse layouts yourself. Choose Browse Layout from the File 
menu to define your own layout or activate a layout previously defined. You can also click 
inside the Browse window with the 'other' mouse button (usually the right) and choose 
Layout from the popup-menu.

See also: Procedures - Change Browse Layout 

Each database uses separate browse layouts.



Changing the sort order

By default the records are sorted on Title.

You may define up to five sort criteria yourself. To change the sort order, choose Change 
Sort Order from the File menu or click inside the Browse window with the 'other' mouse 
button (usually the right) and choose Change Sort Order from the popup-menu.
By default the sort order is not automatically updated when you add a new record. You 
must manually update the sort order by choosing Update Sort Order from the File menu 
or pressing F11. If you want CATBooks to automatically update the sort order each time 
you add a new record, choose Preferences from the File menu and check Data entry - 
Sort automatically.

See also: Procedures - Change Sort Order 

Because it may take some time to update the sort order when you have added a lot of 
records, you may prefer not to automatically update the sort order. Just add all the new 
records, and then update the sort order by choosing Update Sort Order from the File 
menu.



References to other records

CATBooks will automatically create references to other records based on the keywords. 
Choose References from the View to look at the referenced records.
Here is an example how it works:

Book Keywords References

Book 1 database,network,hardwar
e

Book 2, Book 3, Book 4

Book 2 hardware,eide Book 1, Book 4
Book 3 database, Book 1
Book 4 network,eide Book1, Book 2

Looking Up Information

CATBooks features very powerful search capabilities. You can search for all information you 
have entered into the database.
There are five different ways to search:
1. Find. This is the easiest way to search. Simply fill in the fields you want to search in, 

choose OK, and CATBooks handles the rest!
2. Show Field Values. Specify the field you want to search in with the drop-down list. All

unique values are then shown in the list box. Select the value you want to search for 
and choose OK. The number of occurrences for each value is also shown. This might 
be very useful for statistic purposes.

3. Simple Search. Lets you define a search criterion based on one of the fields. You 
specify field, operator and the value you want to search for.

4. Advanced Search. Lets you define a search criterion based on up to 12 fields. You can
group the fields in different ways using parenthesis and the logical operators AND/OR. 
The search criteria can be saved to a file for later use.

5. Cross References. The cross reference dialog box lets you cross reference up to 5 
fields. This is an extremely flexible way to search and query data.

Before you continue, please note that you specify a search criterion this way:
<Field> <Operator> <Value>

<Field> is the field you want to search in and <Value> is the value you want to search 
for. <Operator> is used to compare the value of the field with the value you specified (for 
example contains, less than or between). CATBooks supports the use of wildcards (? 
and *) in connection with the operators Contains and Does not contain. A wildcard is a 
character that substitutes for and enables a match by any of the characters or set of 
characters in its place. The question mark can be thought of as a special character that 
means replace me with any character you like. The asterisk can be thought of as a special 
character that means replace me with none or more occurrences of any character you like.



CATBooks does not distinguish between upper and lower case characters when searching.
It is up to you whether CATBooks should search all records, or only the records that are 
marked (that is, only search the subset). Use the check box Search subset to specify this.
Use the check box Show all to specify whether CATBooks should mark the records found 
during the search and show them (activates the View Subset command), or just show the 
first record found. If you choose the second alternative, choose Show Next from the 
Search menu to show the next record that was found. To show all records found during the
last search, choose Show Result from the Search menu.



Find

This is the easiest way to search. CATBooks includes only the fields you have entered 
values for in the search. Please note that you need to enter two values for some of the 
fields. For example, if you want to search for books released between 1949 and 1955, you 
enter 1949 and 1955 in the text boxes for year.

See also: Procedures - Find 



Show field values

When using this command, you specify the field you want to search in with the drop-down 
list. All unique values are shown in the list box. Select the value you want to search for and 
choose OK. The number of occurrences for each value is also shown. This might be very 
useful for statistical purposes.



Simple search

This command gives you more control. First specify the field you want to search in and the 
operator to use. Then enter the value you want to search for. You may want to choose 
Field values and select a field value from the list (this is the same list that is shown when 
you choose Show Field Values from the Search menu). 
CATBooks supports use of wildcards (? and ) in connection with the operators Contains 
and Does not contain. A wildcard is a character that substitutes for and enables a match 
by any of the characters or set of characters in its place. The question mark can be thought
of as a special character that means replace me with any character you like. The asterisk 
can be thought of as a special character that means replace me with none or more 
occurrences of any character you like.

See also: Procedures - Simple search 



Advanced search

This search command lets you define a search criterion based on up to 12 fields. You can 
group the fields in different ways. The search criterion can be saved to a file for later use. 
You enter information about the sub-criteria you want to include in the query in the same 
way as you do when you use the simple search. For more information, see Simple search.
As you add new fields to search, they are displayed in the list (each field on a single line). 
Add the logical operator OR by pressing the OR button. Two fields that are placed on two 
lines next to each other are grouped by the logical operator AND. You add parentheses by 
choosing either ( or ).
CATBooks lets you save a search criterion, so that you can use it later. Use the Save, Save
as and Open buttons to do this.



Cross references

The cross reference dialog box lets you cross reference up to five fields. This is an 
extremely flexible way to search and query data. The result is shown immediately on the 
screen. You may want to print a report or execute a search based on the cross references.
It is possible to create cross reference based on up to five fields. The dialog box has five list
boxes that show the result of the cross references. 
Placed right over every list are two drop-down lists. You select field from the left list and 
operator from the right list:

= Is equal to
>= Is greater then or equal to
<= Is less than or equal to

The operator is by default set to =, as this is the most likely choice. 
Please note that in many cases if you want to execute a search based on the cross 
references, you may want to set the operator to >=. This is because CATBooks compares 
the field value with the operator when the search is executed. For example, if you create a 
cross reference between an author and all books he has written, and you want to search for
all these books, you need to select the first book and then choose the operator >= before 
the search is executed. If you do not do this, CATBooks will think you want to search for 
exactly the book that is selected in the list (since the operator was set to =).

See also: Procedures - Cross References 1 - Author -> Title 
Procedures - Cross References 2 - Category -> Author -> Title 



Creating Reports

CATBooks has many different reports that you can customize to suit you needs. All reports 
can be easily viewed or printed.
You can customize most of the reports to a certain extent to suit your needs. All reports can
be previewed, printed or sent to a file. We cannot guarantee that the print preview is 100%
accurate. It works best with TrueType fonts.
If you want to make changes to the default printer, choose Print Setup from the File 
menu. You see the standard Windows printer setup dialog box where you can view or 
change your computer's current settings for printer, page orientation (landscape or 
portrait), or paper size. Please note that any changes made to Window's default printer will 
affect all Windows-applications.
The page setup lets you specify margins and what fonts to use. You can use one font for 
the heading and one for the rest of the report. Default page setup is defined by choosing 
Preferences from the File menu, then Report. Settings you make here are used by 
default, but you may override this in the various reports by pressing the Page Setup 
button. In the page setup for each report, you may also specify page numbering and 
columns.
If you want a test print, that is just the first page (50 lines when printing to a file), check 
Test print. Please note that it is possible to cancel the printing by pressing Ctrl+C.
You can enter a heading that is printed in a different font at the beginning of the first page. 
In the heading you can use the code <date>, which causes CATBooks to insert the current 
date. This is very useful when a report layout is saved.
Use Include to specify which records that are printed:
· All
· Subset (that is, records that are marked)
· Filter

A filter specifies which records are included in the report. The filter is defined exactly the 
same way as a search criterion (simple or advanced search). Choose Preferences from 
the File menu, then select Report, Filter to specify if you want to create a simple or 
advanced filter. You may also click on the Filter button with the 'other' mouse button 
(usually the right) and choose this from the popup-menu.

See also: Procedures - Full Report 
Procedures - List Report 
Procedures - Summary Report

All reports can be canceled by pressing Ctrl+C.



The Loan Module

You use the loan module to keep track of books you loan out.



Loan out a book

Follow these steps to register a book as 'on loan':
1. If you do not see the Browse window, open it by double-clicking the Browse icon at 

the bottom of the main window. You may also press Ctrl+B.
2. From the list of registered books, double-click the book you want to loan out. You see 

the Active Record window.
3. Click the Library tab, then click the Loan out button. You see the Loan Out dialog box.

NOTE! You can also choose Loan transactions / Loan out from the Record menu 
(or press Ctrl+F2) to activate the Loan out dialog box.

4. You must now tell CATBooks who is borrowing this book. Type the name or select it 
from the Borrower drop-down list.
NOTE! If you need to specify a new borrower's address, phone number etc., press 
Ctrl+W when the drop-down list has the focus. You see the dialog New Borrower. 
Complete the information requested in the dialog box and click OK.

5. In the text box Date borrowed you specify the date the book was borrowed. Today's 
date is automatically used, but you may change this is necessary.

6. In the text box Date due you specify the date the book must be returned as the latest.
7. Press the OK button to register the book as 'on loan'.

Even though CATBooks lets you change the name of the borrower from the Loan Out dialog
box, always mark the book as returned before you register it as 'on loan' again. This is 
important if you want the statistics report to be correct.



Register books as returned

When the book is returned, you can either click the Returned button in the window Active 
Record or choose Loan Transactions / Returned (Show All) from the Record menu. 
The last option shows a list of all books currently on loan, and is preferred when you have 
many books you want to register as returned.
Follow these steps when you want to register books as returned:
1. Choose Loan Transactions / Returned (Show All) from the Record menu. You see 

the Returned To Library dialog box.
This dialog box lists all books currently on loan. You see these fields: Returned (Yes/No),
Date Due, Title, Catalog Number and Borrower.

2. By default, the books are sorted on Date Due. You may change this from the Sort on 
drop-down list. The books can be sorted on Date Due, Title, Catalog Number or 
Borrower.

3. From the list, select the book you want to register as returned. You do this simply by 
double-clicking it or by pressing the Returned button. You see the status change from 
No to Yes in column one.

4. Repeat step 3 for all books you want to register as returned.
5. Click the Update button to update the database and close the dialog.



Loan reports

There are four reports that are linked to the loan module:
By Borrower Books borrowed grouped by borrower. You can 

choose to include all books that have been 
borrowed, or only the books currently on loan.

By Title Books borrowed grouped by title. You can choose
to include all books that have been borrowed, or 
only the books currently on loan.

On Loan Books currently on loan. You can choose to 
include all books, or only those that are overdue.

Statistics Counts the number of times each book in the 
database has been borrowed.

Creating a Backup Copy of Your Database

Choose Backup from the File menu to create a backup copy of your database. This backup
copy can be used if some unusual event occurs which causes your database to become 
corrupt and non-recoverable. (Normally, FIX will be able to restore your database if it 
becomes corrupt.) Please note that if a database is too large to fit onto one diskette, it is 
automatically split in two or more parts. The file on diskette no. 1 is named 
"dbname".001, the file on diskette no. 2 is named "dbname".002 and so on. 
You may restore a backup by choosing Restore from the File menu. Please note that you 
cannot simply copy the necessary file(s) from the diskette(s) to your hard disk. You must 
use CATBooks' internal routines to do this.
If you want CATBooks to compress the database when taking backup, choose Preferences
from the File menu and check Misc./Use compression - Backup. If you use compression 
the database may occupy as little as ¼ of the original size!

To protect against hard disk failure, you should routinely backup your valuable data files. 
FNProgramvare has no responsibility for any loss of data.



Splitting and Merging Databases

CATBooks lets you work with an unlimited number of databases. It is possible to split a 
single database in two. The marked records will be transferred to the other database. 
These records will either be transferred to a new database or to an existing database. You 
split a database by choosing Split from the File menu.
It is also possible to merge two databases into one. All records from the database you 
merge are transferred. You merge two databases by choosing Merge from the File menu.



What's New

Here's a list of the new features in version 3.2:
· A new loan module that lets you keep track of books on loan, who has borrowed, when 

they were borrowed, when they are due back and how many times they have been 
borrowed. There are four new reports that are linked to the loan module: By Borrower 
(books borrowed grouped by borrower), By Title (books borrowed grouped by title), On 
Loan (books currently on loan) and Statistics (counts the number of times each book 
has been borrowed).

· You can define a fixed size for the window Cover. 
· The field Book ID is renamed to Catalog Number.
· The field Memo is split in three: Comments, Synopsis and Review.
· The windows Active Record 1, Active Record 2 and Keywords are merged into one

window (Active Record). Tabs are used to group the fields: Basic, Library and 
Special. Four of the fields are always visible: Title, Author, Year and Catalog 
Number.

· New fields:
Sort By
Purchased 
Where
Personal 
Rating
On Loan



Other Products from FNProgramvare

CATraxx 
CATBooks 
CATVids 
StampCAT 

Reviews 

You can download these applications from our home page at 
http://www.prodat.no/fnp/eng/.



CATraxx

CATraxx is a quick, efficient, easy-to-use program for organizing your music collection. 
CATraxx is developed by record collectors for record collectors to ensure that you get all 
the features you need.
With CATraxx you can register and look up information about such things as: 

· artist, album title, format, release date,
· company, label, catalog number, 
· condition, playing time, purchase price and current value, 
· song titles, songwriters, producers, 
· studios, musicians, instruments. 

You can add personal comments for both albums and tracks. Twenty special fields enable 
you to customize your catalog. You can even store a bitmap picture of the album cover.
CATraxx uses a relational database model. This means that you register most information 
only once. For example, an artist's name is included in the catalog the first time you add an
album by the artist. Later, you simply choose this name from a list. This type of information
is stored in "lookup" tables which ultimately save time and valuable disk space on your 
computer.
CATraxx lets you work with an unlimited number of databases. This means that you can 
split your collection into different catalogs and organize it to meet your needs. You can also
merge existing databases. CATraxx includes routines for taking and restoring backup of the 
databases you have created.
CATraxx has impressive and powerful search capabilities. You can search for any 
information you have entered in a catalog. CATraxx lets you cross reference up to five 
fields. This is an extremely flexible way to search and query data. CATraxx has templates 
for many types of reports which you can generate to examine on the screen or print out.
CATraxx lets you play CDs from your CD-ROM player.
CATraxx comes with a sample database to get you started and a comprehensive context-
sensitive on-line help system.



CATBooks

CATBooks is a quick, efficient, easy-to-use program for organizing your book collection.
With CATBooks you can register and look up information about such things as: 

· author, title, release year, publisher, country of origin
· condition, category, type, location,
· edition, printing, pages, ISBN, 
· condition, purchase price and current value.

You can add personal comments for every item. Thirteen special fields enable you to 
customize your catalog. You can even store a bitmap picture of the book cover.
CATBooks includes a loan module that lets you keep track of books on loan, who has 
borrowed, when they were borrowed, when they are due back and how many times they 
have been borrowed.
CATBooks uses a relational database model. This means that you register most information 
only once. For example, an authors name is included in the catalog the first time you add a
book written by this person. Later, you simply choose this name from a list. This type of 
information is stored in "lookup" tables which ultimately save time and valuable disk space 
on your computer.
CATBooks lets you work with an unlimited number of databases. This means that you can 
split your collection into different catalogs and organize it to meet your needs. You can also
merge existing databases. CATBooks includes routines for taking and restoring backup of 
the databases you have created.
CATBooks has impressive and powerful search capabilities. You can search for any 
information you have entered in a catalog. CATBooks lets you cross reference up to five 
fields. This is an extremely flexible way to search and query data. CATBooks has templates 
for many types of reports which you can generate to examine on the screen or print out.
CATBooks comes with a sample database to get you started and a comprehensive context-
sensitive on-line help system.



CATVids

CATVids is a quick, efficient, easy-to-use program for organizing your video collection.
With CATVids you can register and look up information about such things as: 

· title, format, type of content, category, length,
· production year, release year, studio, country of origin, distributor,
· writer, producer, director, actors,
· rating, tape counter, recording speed, laserdisc information, location,
· purchase date, price and current value.

You can add personal comments for every item. 18 special fields enable you to customize 
your catalog. You can even store a bitmap picture (for example of the cover).
CATVids uses a relational database model. This means that you register most information 
only once. For example, an actor's name is included in the catalog the first time you add a 
movie where this actor participates. Later, you simply choose this name from a list. This 
type of information is stored in "lookup" tables which ultimately save time and valuable 
disk space on your computer.
CATVids lets you work with an unlimited number of databases. This means that you can 
split your collection into different catalogs and organize it to meet your needs. You can also
merge existing databases. CATVids includes routines for taking and restoring backup of the 
databases you have created.
CATVids has impressive and powerful search capabilities. You can search for any 
information you have entered in a catalog. CATVids lets you cross reference up to five 
fields. This is an extremely flexible way to search and query data. CATVids has templates 
for many types of reports which you can generate to examine on the screen or print out.
CATVids comes with a sample database to get you started and a comprehensive context-
sensitive on-line help system. 



StampCAT

StampCAT is a quick, efficient, easy-to-use program for organizing your stamp collection.
With StampCAT you can register and look up information about such things as: 

· country, catalog no, face value, issue date, design, topic
· color, preformation, condition, watermark, date acquired
· postmark (type, city and date), stamp type
· location, quantity, price and market value.

You can add personal comments for every item. Thirteen special fields enable you to 
customize your catalog. You can even store    a scanned picture of the stamp.
StampCAT uses a relational database model. This means that you register most information
only once. For example, a name of a country is included in the catalog the first time you 
add a stamp from this country. Later, you simply choose this country from a list. This type 
of information is stored in "lookup" tables which ultimately save time and valuable disk 
space on your computer.
StampCAT lets you work with an unlimited number of databases. This means that you can 
split your collection into different catalogs and organize it to meet your needs. You can also
merge existing databases. StampCAT includes routines for taking and restoring backup of 
the databases you have created.
StampCAT has impressive and powerful search capabilities. You can search for any 
information you have entered in a catalog. StampCAT lets you cross reference up to five 
fields. This is an extremely flexible way to search and query data. StampCAT has templates
for many types of reports which you can generate to examine on the screen or print out.
StampCAT comes with a sample database to get you started and a comprehensive context-
sensitive on-line help system. 



Reviews

Shareware Junkies

CATraxx:
"You can add your personal knowledge of the artists, your date of purchase, the studio 
where an individual song was recorded, and on and on and on. There are just too many 
features and details to list."
"It is invaluable for the serious music connoisseur."
Performance: *****
User Friendly: *****
Cost: ***
Ease of Installation: ****
Support: ****

CATBooks:
"This excellent little program catalogs your book collection in a relational database. Lots of 
programs do that, but Catbooks has been particularly well designed and implemented." 
"In addition to a complete bibliographic citation (title, author, publisher, ISBN, publication 
date, and edition) there are slots for condition, purchase date, book type, previous title, 
number of pages, and book location, and nine blank slots for user-defined categories. 
Additionally, there is a well-designed, very informative help file (how many of those have 
you seen recently?), a good search engine, a memo pad for notes on each entry, and a 
report generator with value totals for insurance purposes. There is even a window for 
storing a picture with each record."
Performance: ****
User Friendly: ****
Cost: ****
Ease of Installation: ****
Support: Unknown, little appears necessary.

Benchin' Software Review

CATraxx:
"...I think the program is amazing. I reviewed many music organization programs, and none
had this detail. Actually, it's far more than I need, but for the serious music collector, it is a 
real find. I like the search capabilities -- being able to search for a specific song -- and that 
it provides a detailed insurance record also."
"Incredible indexing with every category possible."




